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About Utilities
Vision controllers offer a broad range of utilities.

VisiLogic offers internal, built

Standalone Software Utilities are
downloaded from http://www.unitronics.com/Content.aspx?page=Downloads

VisiLogic: Internal
SD Cards 

Enhanced Vision controllers support
sized SD cards; V130, V350 and V1070 support micro SD cards. In the V570 
series, the slot is located at the top of the controller; in V130, V350 and V1070 
the slot is located on the right side.

What can I do with an SD card?
"Clone" a complete PLC, 
elements. 

 SD Ladder Functions
and PLC memory operands, including 
Trend data. 

 Store Alarms History on SD.
Use Information Mode or 
OS firmware and compressed VisiLogic
operand values to/from an SD card, and to backup and even completely 
'clone' a PLC. 

 Use Unitronics' SD Card Explorer, included in the SD Card Suite, to 
transfer SD files from PLC to PC
card, send files via email attachment.
View and execute files on the PLC display via the HMI element 
Browser. 

 Host complex Web pages using the program in the .zip file located at:
http://www.unitronics.com/data/uploads/communication/WebServer.zip.
Use the tools in SD Card Suite to:
- Format the SD Card.
- Convert, view, and read/write the data to/from PC.
- Export that data to Excel or as an .csv file.
- Remotely view, open, copy, or delete SD c
Ethernet. 
This standalone software is available from: 
http://www.unitronics.com/Content.aspx?page=Downloads

a broad range of utilities.
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Note ♦ Previous to the year 2008, controller models V570, V130, and V350 
were produced with stickers covering the SD slots. In order to use the 
SD slot, peel off the sticker. 
VisiLogic V7.00 and OS versions OS 1.3.00 and up support SD Cards. 
OS versions 2.23 and higher support SDHC (SD High Capacity) cards. 

♦ Use fast SD cards from a reputable manufacturer with a capacity of at 
least 1G. 

♦ The PLC supports SD cards with a single partition, which may be 
equal to the capacity of the card. 

Before you begin: SD Card Suite 
First, you must download and install the SD Card Suite from the Downloads 
page at http://www.unitronics.com. The Suite contains the SD Card Manager 
and utilities you must have to work with an SD card. 

Before you insert the SD card into the PLC, you must connect the card to your 
PC and format it according to the instructions in the SD Card Manager.
This formatter embeds the necessary framework, creating a folder structure on 
the SD card; when the application writes data to the SD, it will write it to the 
appropriate folder. 

http://www.unitronics.com/Content.aspx?page=Downloads
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The SD Card Manager also contains a calculator which reports how long your 
application will take to fill the card to capacity. Run this before you insert the 
card. 

To insert the card, slide it into the slot and lightly press it until it clicks into 
place. This click engages the spring that holds the card. To remove the card, 
press it lightly and release; the spring pops the card up. 

 
SD and Information Mode  
When you enter
Information Mode and 
select SD, you see buttons 
representing all available 
categories of data that can 
be downloaded to the SD 
and uploaded to the 
controller. Press a button, 
and then select upload or 
download. You can use 
these features to back up 
applications and values, 
transfer operand and Data 
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Tables between 
controllers--even to clone 
a complete PLC application 
including data. 
 
In all cases, you first select 
the category of data, and 
then the direction of the 
action, Download to SD or 
Upload to PLC. After this, 
follow the on-screen 
directions. 

 

Note ♦ You can only download data to an SD Card that is guarded with a 
password. Information mode requests the password before carrying 
out the operation. The only exception is Firmware.

Information Mode Actions
Note ♦ These actions have parallel Ladder functions: SD Clone functions.

Firmware You can download an OS to the SD card; the extension of the 
resulting file will be:

V130: .O13
V350: .O35
V570: .O57

You can download either Application or Application + .vlp from the PLC to the 
SD card; the extension of the resulting files will be:

V130: .V13 
 V350: .V35 
 V570: .V57 

You can upload these applications from the SD card to the
Mode.   

You can also create V13, .V35, and .V57 files via VisiLogic, by selecting Project> 
Create Project flies. You can then store them in this folder, and install them via 
Information Mode>Application> Upload to PLC, or via the SD 

Application If you select this category, and download the application to 
SD, the application will not include an editable upload image
-even if the application in the controller was downloaded 
including the Burn Upload option.

Application 
+ .vlp 

Note that you can only select this category if the application 
in the controller was downloaded including the Burn Upload 
option.
If you select this category, and download the application to 
SD,the application includes an editable upload
if you use Information Mode to upload the application to a 
PLC, you can upload the application to VisiLogic for editing.

Data Table If you use Information Mode to download a Data Table from the 
PLC to an SD Card, it creates a single .fdt f
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file copies the entire Data Table section from the PLC's RAM 
memory--
When you upload the .fdt to the PLC, it overwrites the entire 
Data Table section

Operand If you download operand data from the PLC to an SD Card, it 
takes all of the current operand values and creates a single file; 
the extension of the resulting file will be:

V130: .D13
V350: .D35
V570: .D57

If you upload this to the PLC it overwrites all PLC operand data.

Cloning The process described below 
PLC, if both support SD cards. The process takes all of the 
data: the Ladder control program (including an upload file if 
this option was selected at download) the HMI application 
including fonts and images, the OS, com
including data, webserver definitions, String Library, and all 
operand values.
Note  ♦
must be identical. 

1. Insert a 
clone.

2. Enter Information mode.
3. Select the SD option.
4. Select Clone, then Download to SD. The PLC will create a 

Clone file containing the OS, the HMI and Ladder 
applications, all operand values, Data Tables and their 
values, web s
V130: .C13
V350: .C35
V570: .C57
Note that you can also open these files with VisiLogic, and 
edit the application.

5. Remove the SD card, and insert it into another PLC of the 
same model.

6. Select Clone, then Upload to P
installs the clone application

You can also create .Cxx files via SD Clone Functions, or in 
VisiLogic, by selecting Project> Create Project files. You can 
then store them in this folder, and install them via Information 
Mode, or via th
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SD Card: Folders and File Types
The following figure shows the folders that are created by SD Tools. These 
folders may contain the files described below.

Folder
Alarms

DT

EXCEL

Log

SdBLocks

System

Types
ws the folders that are created by SD Tools. These 
files described below.

r Purpose
ms If a PLC contains an SD card, the PLC 

application comprises Alarms, and Log to 
History is selected in the Alarms 
Configuration, the PLC stores Alarms in a 
.ual file in this folder. 
Note that SB 352 SD: Write Alarm History to 
SD (OFF by default) must be turned ON.
This can contain two kinds of files:

.fdt - When a user uses Information 
Mode to download a Data Table from 
the PLC to an SD Card, it creates a 
single .fdt file in he main DT folder.
.udt - The Ladder function DT to SD 
creates .udt files and saves them in this 
folder, or in one of four sub
Note that the main DT folder and 
subfolders DT1, DT2, DT3, DT4 can 
each contain 64 files, for a total of 320 
.udt files. 
 

EL The Ladder function Create Delimited Line
pulls PLC data, including text strings and 
saves it to a vector of operands.
The function Write Delimited Line
data to build either a .csv or .txt line, and 
can write it to (or create) an Ex
folder, or in one of four sub
Note that the main EXCEL folder and 
subfolders EXCEL0, EXCEL1, EXCEL2, 
EXCEL3 can each contain 64 files, for a total 
of 320 .csv files. 
When the Ladder function W
SD runs, it logs lines from the specified 
table to a single file called UNILOG.ulg in 
this folder. 

Locks Your Ladder application can create up to 4 
SD Data Block .udb files in this folder: 
Block0.udb, Block1.udb, Block2.udb, and 
Block3.udb.  SD Block functions read/write 
blocks of raw data between operands and 
these .udb files. 

tem When you upload/download an OS from 
the PLC using Information Mode, it 
via this folder. These may be .O13, 
.O35, or .O57 files. 

 When you create a Clone file via 
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Trends

User_App

Web

SD System Operands  
# Description 
SB 217 SD Card Present 

SB 218 SD Card Write 
Enabled 

SB 219 SD FIFO Empty (SD 
Card may be 
Ejected) 

•
•
•

SBs 324-29 are linked to the SD File utilities.
SB 324 SD: Open File (Read 

to SD) 
(Status messages in 
SI 67) 

SB 325 SD File: Read Chunk 
in Progress (a Chunk 
is 512 bytes long) 

SB 326 SD Read File: End Of 
File (EOF, entire file 
has been read) 

Information Mode, the file is stored in 
this folder. When you install Clone file 
from an SD card to a PLC, Information 
Mode looks in this folder for the 
appropriate file: .C13, .C35, or C57

nds When the Ladder function W
runs, it creates .utr files in this folder. Note 
that you can use this function to create up 
to 4 subfolders in your Ladder
These are named Trends1, Trends2, 
Trends3, Trends4. 
Note that the main Trends folder and 
subfolders can each contain 64 files, for a 
total of 320 .utr files. 

r_App Via either Ladder function or Via 
Information Mode, you can create a 
compressed application from the PLC 
into this folder; these files will use 
extensions as follows: V130: .V13, 
V350: .V35, V570: .V57
You can backup all current operand 
values;these files will use extensions as 
follows: V130: .D13, V350: .D35, 
V570: .D57 

You can use Windows Explorer to store any 
type of file into this folder, such as .html or 
.jpg. Your Ladder application can read these 
files in 'chunks' of 512 bytes via the 
functions. 

Turns ON when: Turns OFF when:
An SD Card is in the slot, 
and is formatted to 
FAT32 

SD Card is not found, or is 
incorrectly formatted

Write is enabled:  the 
card's write-protect lock 
is off 

Write is disabled: the card's 
write-protect lock is on

• Power-up 
• No SD Card is in Slot 
• No SD requests exist 

There are no SD requests 
pending, such as Data Table 
Copy/Log, Alarms, or from 
Info Mode 

the SD File utilities.
When Ladder function SD 
File: Open successfully 
activates a file for Read 

When Ladder function SD 
File: Close finishes closing 
an open file and SB 327 
(EOF) turns ON 

When the Ladder function 
SD: Get Next File Chunk 
is reading a chunk into a 
vector 

When the Ladder function 
SD: Get Next File Chunk has 
finished reading the chunk

When the When the 
Ladder function SD: Get 
Next File Chunk reads the 

When the last chunk ha
been read, and when Ladder 
function SD File: Close start
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final Chunk File: Close 
SB 327 SD: Open File (Write 

to SD) 
(Status messages in 
SI 67) 

When Ladder function SD 
File: Open successfully 
activates a file for Write 
on a SD card 

 

SB 328 SD File: Write Chunk 
in Progress (a Chunk 
is 512 bytes long) 

When the Ladder function 
SD: Get Next File Chunk 
is writing a chunk into a 
vector 

 

SB329 SD Write File: End Of 
File (EOF, entire file 
has been read) 

When the When the 
Ladder function SD: Get 
Next File Chunk writes 
the final Chunk 

 

SB 340 Log to SD in Progress Row is being copied from 
DT to SD Card 

When copy is complete OS 

SB 341 Write Data Table 
from PLC to SD in 
Progress 

Entire Data Table is being 
copied from DT to SD 
Card 

When the Write process is 
complete 

OS 

SB 342 Read Data Table 
from SD to PLC in 
Progress 

Entire Data Table is being 
copied from  SD Card to 
DT 

When the Write process is 
complete 

OS 

SB 343 File Report in 
Progress 

While Report process is in 
progress 

When the Report is 
complete 

OS 

SB 345 Email Send in 
Progress 

ON when function is busy

SB 344 Write delimited line 
to SD in Progress 

While line is being written When the Write process is 
complete 

OS 

SB 346 SD Data Block 0 
Busy 

When a Write or Read 
utility is being run on a 
Data Block 

When no utility is running OS 

SB 347 SD Data Block 1 
Busy 

SB 348 SD Data Block 2 
Busy 

SB 349 SD Data Block 3 
Busy 

SB 352 SD: Enable writing 
Alarm History to SD 

Turned ON by user to 
write Alarm History to SD 
Card 

Off by default. 
Causes the PLC to write 
Alarm History to the PLC 

At Power-
up, or by 
user 

SB 358 SD: Delete File in 
Progress 

ON when function is busy OFF when function is not 
busy 

OS 

SB 359 Folder Report 
Function in Progress 

ON when function is busy OFF when function is not 
busy 

OS 

SB 366 Clone in Progress 
(Process can take 
from several seconds 
to several minutes) 

ON when function is busy OFF when function is not 
busy 

OS 

# Description Value Comments 
SI 63 Maximum number of 

Trend files that can be 
saved (read-only) 

0-64 
The maximum amount of Trend 
files (*.utt files) in a single folder 
is 64. The value in SI 634shows 
the number of remaining *.utr 
files; if 5 *.utr files exist, SI 64 
= 59 

• Initialized at Power-up 
• Updated when:SB 217 is 

ON and SB 341 turns ON 
 

SI 64 
 

Maximum number of DT 
files that can be saved 
(read-only) 

0-64 
The maximum amount of Data 
Table files (*.udt files) in a single 
folder is 64. The value in SI 
634shows the number of 
remaining *.udt files; if 5 *udt 

• Initialized at Power-up 
• Updated when:SB 217 is 

ON and SB 341 turns ON 
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files exist, SI 64 = 59 
SI 66 SD Card Status 

Messages 
This SI is a bitmap; a bit turns 
ON to indicate status. 
• All bits OFF – No errors 
• Bit 1 – Read: End Of File 

indication 
• Bit 2 – Can't open file 
• Bit 3– Error while writing to a 

file 
• Bit 4 – Error while reading 

from a file 
• Bit 5 – Failed to close a file 
• Bit 6 – SD is full 
• Bit 7 – Path not found 
• Bit 14 - Turns ON when SD is 

inserted into slot and PLC 
runs checks, turns OFF when 
SB 217 turns ON 

• Initialized at Power-up. 
• While the application is 

running, the user 
application must reset the 
bits. 

SI 67 SD Card, Read Files: 
Status 

Value 
0= No error 
1= No SD card in Slot 
2= Vector is not long enough to 
contain data (may be at upper 
address limit of that  data type) 
3= Path to SD file not found 
4=Another file is currently open 
5 = File is closed 
6 = Busy: previous request in 
progress 
7 = File Open Error 
8 = Read Error 
9 = File Close error 

SI 67 reports status for the 
following SD File utilities: 

• Read SD File: Open 
• Read Next File Chunk 
• Read SD File: Close 

 

SI 68 SD Card, Write Files: 
Status 

Value 
0 = No error 
1 = No SD card in Slot 
2 = Vector is not long enough to 
contain data (may be at upper 
address limit of that  data type) 
3 = Path to SD file not found 
4 = Another file is currently open
5 = File is closed 
6 = File Open error 
7 = Write Error 
14 = File Close error 

SI 68 reports status for the 
following SD File utilities: 

• Write SD File: Open 
• Write Next File Chunk 
• Write SD File: Close 

SI 69 SD Card: File Open Time 
(may signal file 
fragmentation) 

Time required to open SD files, 
in units of 10mSec. 

Each time a file is opened, the 
OS updates this value. 
A typical first write (open + 
write) = approx. 500mSec, 
typical first read (open + 
read)= approx. 60mSec 
 
Over time, this may increase 
due to file fragmentation. 
 
If the time becomes to great, 
the card should be reformatted
Reset at Power-up and when 
SD card is removed. 

SI 76 SI 76 Number of Alarms 
currently in History 
Buffer 

Shows the number of Alarms in 
the history buffer. 

If SB 352 SD: Write Alarm 
History to SD is ON, the 
Alarms in the buffer are 
automatically written to the SD 
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card. 
Initialized by the user, or when 
the PLC is initialized. 

SI 160 SD Trend 1 status This SI is a bitmap; a bit turns 
ON to indicate status when the 
function Start Saving Trend to 
SD runs. 
• All bits OFF – No errors 
• Bit 4 – Start Saving Trend is 

in progress for another Trend
• Bit 7 – This Trend does not 

exist (may result when an MI 
is used to provide the Trend 
number, and the value points 
to a non-existent Trend) 

• Bit 8 – Start Saving Trend is 
in progress for this Trend 

• Bit 9 – Start Saving Trend 
failed 

SI 161 SD Trend 2 status 
SI 162 SD Trend 3 status 
SI 163 SD Trend 4 status 
SI 164 SD Trend 5 status 
SI 165 SD Trend 6 status 
SI 166 SD Trend 7 status 
SI 167 SD Trend 8 status 

SI 330 SD: Write DT from PLC 
to SD - Total Amount of 
Data to be Copied 
(blocks of 512 bytes) 

When the application runs the 
function Copy Data Table to SD, 
SI 330 shows the total number 
of blocks of data to be copied 
from the PLC. 

Initialized at Power-up 

SI 331 SD: Write DT from PLC 
to SD - Remaining 
Amount (blocks not yet 
copied) 

Shows how many blocks of data 
remain to be copied. 
The value increases by 1 each 
time a block is copied. 

Initialized: 
• When the PLC begins to 

copy a new block of data to 
the SD card 

• At Power-up. 
SI 332 SD: Read DT SD to PLC -

Total Amount of Data to 
be Copied (blocks of 512 
bytes) 

When the application runs the 
function Copy Data Table to PLC, 
SI 332 shows the total number 
of blocks of data to be copied 
from the SD. 

Initialized at Power-up 

SI 333 SD: Read DT from SD to 
PLC - Remaining Amount 
(blocks not yet copied) 

Shows how many blocks of data 
remain to be copied. 
The value increases by 1 each 
time a block is copied. 

Initialized: 
• When the PLC begins to 

copy a new block of data 
from the SD card 

• At Power-up. 
# Description Value Comments 

SDW 
59 

SD Card: Free space 
(bytes) 

Capacity given in 512-byte 
chunks. 
The value is written when SB 
217 turns ON, and is updated at 
each write operation. The 
operand is reset when SB 217 
turns OFF. 

• Initialized at Power-up. 

SD Ladder Functions 
Use the SD ladder functions to read and write data to and from an SD card. 

The functions are located on the SD menu on the Ladder toolbar. 
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If you include SD functions in your 
application, build a net that uses SB 
217 to check that the SD card is in 
the PLC and correctly formatted, 
and SB 218 to check that the card is 
write-enabled, if it contains a write-
protection tab 
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SD card Functions 

Category Purpose Functions
SD 
Password 

Use this to guard SD data. Set SD Card Password 

Folder 
Report 

Reports the number of files 
currently in an SD folder, and 
the number of files can still be 
created in that folder. 

Folder Report Function

SD Data 
Table

Use these to read and write 
data between  Data Tables 
and SD card. 

Log Data Table Row to SD 
Card 
Copy PLC Data Table to SD 
Copy SD to PLC Data Table 
Find Index or Tag in .udt 

SD Trend Record an entire or partial 
trend to a .utr file in the SD 
card Trends folder 

Save Trend to SD Card
Stop Saving Trend to SD 

SD Excel Use Create Excel Line to pull 
numeric data or text strings 
from the PLC and use 
delimiters to structure a line; 
then use the function Write 
Delimited Line to create an 
Excel file on an SD Card. 
The functions can create .csv 
and .txt lines 

Create Excel Delimited 
Line 
Write Excel Delimited Line 
to SD 

Data 
Blocks 

Use these to create data 
storage areas in the SdBLocks 
folder on a SD card. 
SD Data Blocks may reach a 
total of 4G, or a single Block 
may be up to 4G. A Data 
Block comprises Sub-Blocks of 
512 Bytes 

Create SD Block
Read from SD Block to 
Vector 
Write from Vector to SD 
Block 

Data Files Use Windows Explorer to store 
any type of file onto an SD 
card, such as .html or .jpg. 
The SD File Functions enable 
your Ladder application to 
read and write these files in 
'chunks' of 512 bytes. 
You can also use these 
functions to pull data from the 
PLC and create files on the SD 
card. 

SD File: Open
Read/Write next Chunk 
SD File: Close 
Delete SD File 
SD File Info 
Rename SD File 

Safely 
Remove 
SD 

Use this to ascertain when an 
SD card may be safely 
removed from the PLC 

Remove SD

Clone 
to/from 

Use this to clone a complete 
PLC and application, Data 

Clone to/from SD
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SD Tables, or operand values 
from a PLC or install such 
clone files to a PLC of the 
same model 
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PLC Name
If you apply a PLC name, the PLC writes this name to the files it creates on the 
SD Card. 

 HMI Progress Bar
You can use SI 330 and SI 331 to create a progress bar on an HMI display that 
shows when the PLC is writing data to the SD; and SI 332 and SI333 to sho
data being written from the SD to the PLC. 
elements shown in the following image. Note that the PLC copies data at a rate 
of .5k per second. This means that a PLC requires approximately 24 seconds to 
transfer a Data Table comprising 120k to an SD card.

Removing the SD Card
To indicate that the SD card may be safely removed, you can link an HMI 
element to SB 219 SD FIFO Empty (SD Card may be Ejected).

Set SD Card Password 
You can guard the SD card with a password.

Note that when the PLC is in Information Mode, a user can only download data 
to an SD card: 

 If the SD is guarded with a password.
If the user can supply the password. The only exception is Firmware, 
which may be downloaded without password.

Note ♦ The SD Password is case

The maximum Password length is 8 bytes. Each register byte contains one 
character. 

1. Place a Set SD Password function in the Ladder; you can either directly 
assign a text password, or provide it via MI.

e, the PLC writes this name to the files it creates on the 

SI 331 to create a progress bar on an HMI display that 
writing data to the SD; and SI 332 and SI333 to sho
the SD to the PLC. To create a progress bar, use the 
ollowing image. Note that the PLC copies data at a rate 
means that a PLC requires approximately 24 seconds to 
mprising 120k to an SD card.

card may be safely removed, you can link an HMI 
FIFO Empty (SD Card may be Ejected).

ard with a password.

is in Information Mode, a user can only download data 

d with a password.
ply the password. The only exception is Firmware, 
nloaded without password.

ord is case-sensitive

d length is 8 bytes. Each register byte contains one 

sword function in the Ladder; you can either directly 
word, or provide it via MI.
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HMI display that 
SI333 to show
ss bar, use the 
es data at a rate 

ely 24 seconds to 

ink an HMI 

y download data 
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contains one 

either directly 
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SD Card: Folder Report Function
Use this Function to see:

The number of files are currently in an SD folder
The number of files can still be created in that folder

Notes ♦ The function reports only on the types of files that
particular folder. For example, each Data Table folder (DT) may 
contain a maximum of 64 .udt files. If Folder Report is set to DT 
folders, it only reports the number of .udt file. If there are other file 
types present in the folder, they a

♦ If there are fewer files than the maximum allowed, but the SD card 
capacity is exceeded, SI 66 will indicate SD Card Full.

♦ Use SB 343,SD: File Report in Progress, as a condition to running 
the function 

Parameter Name 

Input SD Folder: Select 
SD Folder 

nction
:

are currently in an SD folder
can still be created in that folder

reports only on the types of files that a
der. For example, each Data Table folder (DT) may 
ximum of 64 .udt files. If Folder Report is set to DT 
y reports the number of .udt file. If there are other file 
t in the folder, they are ignored. 
ewer files than the maximum allowed, but the SD card 
xceeded, SI 66 will indicate SD Card Full.
SD: File Report in Progress, as a condition to running 

Purpose 

ct Either select a folder, or link an operand. To use an operand 
value to access folders, use the numbers shown in Select 
SD Folder; where '1' will access the main DT folder, and 
'101 will access folder DT2. 
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re linked to a 
er (DT) may 
t is set to DT 
ere are other file 

but the SD card 
ll.
on to running 

d. To use an operand 
s shown in Select 
n DT folder, and 



VisiLogic: Utilities 

VisiLogic: Utilities 

Output 
 

Number of files 
currently in Folder

Number of Files that 
may still be created

Folder Report: 
Status Operand

Folder Report: 
Success Bit 

Note SB 359: Folder Report 

SD Card and Data Table Functions (Ladder)
These functions enable you to:

Log a single row of data from a Data Table into a .ulg file located on the 
SD card 

 Write all or part of a Data Table into a .udt file located on the SD card
Read all or part of an SD card .udt file to a Data Table
Search for tagged sections in a .udt file

If a Data Table is marked as Part of Project, you 
log lines from it to an SD card.

# Description 
SI 64 Maximum number of DT 

files that can be saved 
(read-only) 

der
The number of files currently in Folder (max = 64 per 
folder) 

that 
ated

The number of files that may still be created (max = 64 per 
folder) 

This MI is a bitmap; a bit turns ON to indicate status.
The MI is initialized when the function starts.

• All bits OFF – No errors, and the SD card is idle
• Bit 1 - SD Card internal error 
• Bit 2 - SD file is incorrect type 
• Bit 3 - There is no SD card in the slot
• Bit 4 - The SD card has failed (Check SI 66)
• Bit 5 - Path not found 

Turns ON when the Report is complete. It remains ON until 
it is reset by the application, or until the application calls 
the function. 

port Function in Progress (ON when function is busy)

nctions (Ladder)
you to:

data from a Data Table into a .ulg file located on the 

a Data Table into a .udt file located on the SD card
an SD card .udt file to a Data Table
sections in a .udt file

e is marked as Part of Project, you cannot
it to an SD card.

Value Comments 
0-64 
The maximum amount of 
Trend files (*.udt files) in a 
single folder is 64. The 
value in SI 634shows the 
number of remaining *.udt 
files; if 5 *udt files exist, SI 
64 = 59 

• Initialized at Power
• Updated when:SB 217 is ON and 

SB 341 turns ON

SD Cards
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max = 64 per 

eated (max = 64 per 

dicate status.
tarts.
e SD card is idle

e slot
Check SI 66)

It remains ON until 
e application calls 

nction is busy)

located on the 

the SD card

nnot copy it or 

Power-up 
n:SB 217 is ON and 
ON
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Log Data Table Row to SD Card 

1. To log a row from a Data Table, build a net that includes the function SD> 
Write Log Line to SD. 
Use SB 340 to ensure that the PLC is not currently logging a row to the 
SD card. 
 
When the application writes this type of data to the SD card, it creates a 
single file called UNILOG.ulg in the LOG folder, and then appends each 
new line from the selected Data Table to this log file. 
 

Parameter 
Name 

Purpose 

Source Selects the Data Table you want to log from. 

Row index Determines which row in the table will be logged. 

Status 
messages 

This MI is a bitmap; a bit turns ON to indicate status. 
The MI is initialized when the function starts. 
 

All bits OFF – No errors, and the SD card is idle 
Bit 1 – The SD card was formatted in an SD Tools version that is not 
compatible with the VisiLogic application in the PLC. or VisiLogic version 
is not compatible with the PLC OS. Check to see if you need to update 
versions. 
Bit 2 – The data in the SD is not compatible with the data in the Data 
Table 
Bit 3 – Data checksum error 
Bit 4 – Failed to open file 
Bit 5 - Failed to write to the SD file 
Bit 6 - Failed to close file 
Bit 7 - In progress 
Bit 8 - No SD card found 
Bit 9 - SD error, check SI 66 for error message 
Bit 10 – Requested Data Table does not exist 

Success Bit Turns ON when the data is successfully written to the SD card. It remains ON until 
it is reset by the application, or until the application calls the function. 
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Data Table To / From SD Card
The Ladder function DT to SD creates .udt files and saves them in the main DT 
folder or in one of four sub-folders. DT1, DT2, DT3, DT4. 
Each folder can contain 64 files, for a total of 320 .udt files. 

Write Data Table to SD  (Copy DT to SD) 

1. To copy an entire or partial Data Table, build a net that includes the 
function SD> Write DataTable to SD. 
Use an inverted contact of SB 341 to ensure that the PLC is not currently 
writing to the SD card. 

2. Set the options to copy all or part of a Data Table. 
 
When the application writes this type of data to the SD card, it creates a 
file with the extension .udt in the selected DT folder. 
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Parameter 
Name 

Purpose 

Source: 
Data Table to 
copy 

Selects the Data Table you want to write from. 

Copy options Select to copy all or part of a Data Table. 
Selecting Copy enables the Start Row and Number of Rows parameters. 

Target: SD Folder This is where the .udt file will be stored on the SD card. You can select the 
folder, or provide the Folder number via register. Values point to folders as 
follows: 1=the main DT folder, 100=DT1, 101=DT2, 102=DT3, and 
103=DT4. 

.udt File Name Can be up to 8 characters long, and may be provided by constant text or 
register. Note that if the name comes from an MI, the function copies a 
vector 8 bytes long, or until it finds a 'null' character. 

Overwrite/Append If the function finds a .udt file in that folder of the same name, 
• Selecting Overwrite replaces the file. 
• Selecting Append adds the new data to the existing .udt file. You can 

assign a unique name (DT Tag) to each appended section, marking 
the sections for later use in your program. 
The Tag may contain up to 16 characters. 

Status messages This MI is a bitmap; a bit turns ON to indicate status. 
The MI is initialized when the function starts. 
 

All bits OFF – No errors, and the SD card is idle 
Bit 1 – The SD card was formatted in an SD Tools version that is not 
compatible with the VisiLogic application in the PLC. or VisiLogic 
version is not compatible with the PLC OS. Check to see if you need 
to update versions. 
Bit 2 – The structure of the .udt file and the Data Table are not 
identical 
Bit 3 – Data checksum error. Please send application and any related 
information to support@unitronics.com. 
Bit 4 – Failed to open file 
Bit 5 - Failed to read from file 
Bit 6 - Failed to close file 
Bit 7 - In progress 
Bit 8 - No SD card found 
Bit 9 - SD error, check SI 66 for error message 
Bit 10 – Requested Data Table does not exist 

Success Bit Turns ON when the data is successfully written to the SD Card. It remains ON 
until it is reset by the application, or until the application calls the function. 

Note ♦ The maximum number of Data Table files that can be created in a 
folder SD card is 64, including the main DT folder. 

Read .udt file from SD to PLC Data Table (Copy SD >DT) 

1. To copy .udt data from an SD card into a Data Table, build a net that 
includes the function SD> Copy Data to PLC Data Table. 
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Use an inverted contact of SB 342 to ensure that the PLC is not reading 
writing from the SD card. 
Note that in order to copy data, the Data Table structure in both PLC and 
SD card must be identical: equal number of rows, equal numbers of 
columns, and column data types. 
 

Parameter 
Name 

Purpose 

Select SD 
Folder 

This is where the source .udt file is on the SD Card. You can select the folder, or 
provide the Folder number via register. Values point to folders as follows: 1=the 
main DT folder, 100=DT1, 101=DT2, 102=DT3, and 103=DT4. 

File Name The Table Name can be up to 8 characters long, and may be provided by constant 
text or register. 

Read Options If the .udt file contains appended sections, you can search for a Numeric or Text 
Tag. 

Target: Data 
Table 
 

Click on the drop-down arrow to select a Data Table in the project. 
The Table Name can be up to 8 characters long, and may be provided by constant 
text or register. Note that if the name comes from an MI, the function copies a 
vector 8 bytes long, or until it finds a 'null' character. 

Status 
Operand 

This MI is a bitmap; a bit turns ON to indicate status. 
The MI is initialized when the function starts. 

• Bit 1 – The SD card was formatted in an SD Tools version that is not 
compatible with the VisiLogic application in the PLC. or VisiLogic version is 
not compatible with the PLC OS. Check to see if you need to update 
versions. 

• Bit 2 – The data in the SD is not compatible with the data in the Data 
Table 

• Bit 3 – Data checksum error 
• Bit 4 – Failed to open file 
• Bit 5 - Failed to read from file 
• Bit 6 - Failed to close file 
• Bit 7 - In progress (SB 342 ON) 
• Bit 8 - No SD card found (SB217 (ON) 
• Bit 9 - SD error, check SI 66 for error message 
• Bit 10 – Requested Data Table does not exist 
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Success Bit Turns ON when the data is successfully read. It remains ON until it is reset by the 
application, or until the application calls the function. 

Search .udt for Tag or Index# 

If a .udt file was created using appended sections, you can search it for the 
index number or tag name. 

Use an inverted contact of SB 342 to ensure that the PLC is not reading writing 
from the SD card. 

 

Parameter 
Name 

Purpose 

Select SD 
Folder 

This is where the source .udt file is on the SD Card. You can select the folder, or 
provide the Folder number via register. Values point to folders as follows: 1=the 
main DT folder, 100=DT1, 101=DT2, 102=DT3, and 103=DT4. 

File Name The Table Name can be up to 8 characters long, and may be provided by constant 
text or register. 

Tag Type Search for a Numeric or Text Tag. 

Table 
 

Click on the drop-down arrow to select a Data Table in the project. 
The Table Name can be up to 8 characters long, and may be provided by constant 
text or register. Note that if the name comes from an MI, the function copies a 
vector 8 bytes long, or until it finds a 'null' character. 

Status 
Operand 

This MI is a bitmap; a bit turns ON to indicate status. 
The MI is initialized when the function starts. 

• Bit 1 – The SD card was formatted in an SD Tools version that is not 
compatible with the VisiLogic application in the PLC. or VisiLogic version is 
not compatible with the PLC OS. Check to see if you need to update 
versions. 

• Bit 2 – The data in the SD is not compatible with the data in the Data 
Table 



VisiLogic: Utilities SD Cards

VisiLogic: Utilities 23

• Bit 3 – Data checksum error 
• Bit 4 – Failed to open file 
• Bit 5 - Failed to read from file 
• Bit 6 - Failed to close file 
• Bit 7 - In progress (SB 342 ON) 
• Bit 8 - No SD card found (SB217 (ON) 
• Bit 9 - SD error, check SI 66 for error message 
• Bit 10 – Requested Data Table does not exist 

Success Bit Turns ON when the tag is found. It remains ON until it is reset by the application, 
or until the application calls the function. 
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Import data from an SD card into a PLC Data Table
This imports data from a Data Table on the SD card into a Data Table in the 
PLC. 

The Data Tables must be identical. In order to ensure this, follow the recipe 
below. 

1. Open the Data Table, 
and click Export the Data 
Table Structure to 
convert the table to an 
.xml file. 

2. From the VisiLogic Tools 
menu, open SD Tools. 

3. From the SD Tools Tools 
menu, open DB Tools. 

4. Navigate to and select 
the .xml file. 

5. SD Tools opens the file 
for editing. 
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6. Click on table cell to edit 
the values. 

7. From the File menu, 
select Build DT for PLC. 

8. Copy the resulting .udt 
file to the SD card, and 
then place it in the PLC. 
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9. Build a net including the 
SD utility DT to PLC. 

When the Program runs, it will copy the values from the Data Table on the SD 
card into the PLC Data Table cells. 

 

SD Card and Trends 
Use the Start Saving Trend to SD to record an entire or partial trend; and Stop 
Saving Trend to halt the recording process. 
 
When the application writes this type of data to the SD card, it creates a file 
with the extension .utr in the Trends folder. Each time you start and stop 
saving the Trend, the application adds a new segment to the file. 

 

Parameter 
Name 

Purpose 

Source Trend 
Number 

Click on the drop-down arrow to select a Trend in the project. 

Target SD .utr file Link an operand to provide a file name. Note that you MUST provide a file 
name. If the linked register is empty, the Trend will not be recorded to the 
SD. This is where the .udt file will be stored on the SD card. You can select 
the folder, or provide the Folder number via register. Values point to folders 
as follows: 1=the main DT folder, 100=DT1, 101=DT2, 102=DT3, and 
103=DT4. 

Status Operand This MI is a bitmap; a bit turns ON to indicate status. 
The MI is initialized when the function starts. 

• Bit 1 – The SD card was formatted in an SD Tools version that is not 
compatible with the VisiLogic application in the PLC. or VisiLogic 
version is not compatible with the PLC OS. Check to see if you need 
to update versions. 
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• Bit 2 – The data in the SD is not compatible with the data in the 
Data Table 

• Bit 3 .-.Data checksum error 
• Bit 4 – Failed to open file 
• Bit 5 - Failed to read from file 
• Bit 6 - Failed to close file 
• Bit 7 - In progress 
• Bit 8 - No SD card found 
• Bit 9 - SD error, check SI 66 for error message 

Success Bit Turns ON when the data is successfully written to the PLC Data Table. It 
remains ON until it is reset by the application, or until the application calls 
the function. 

Displaying the saved Trend 
You can display Trend curves directly from a .utr file by using the HMI element 
Trend from SD. 

Link SBs 117 and 118 with HMI buttons to enable users to jump between 
segments. Use the inverted contact of SB119 as a condition as shown below. 

 

When you save a Trend to an SD card, each time you start and stop the save, another segment is 
added to the .utr file.  

# Description Turns ON : Turns OFF : Reset by: 

SB 116 SD Trends to SD: Set 
to Overwrite .utr 

User application User 
application 

User 

Use these to control the display of Trend segments on the HMI screen. Use the inverted contact of 
SB119 as a condition. 

SB 117
SD Trends: Jump to 
next segment User application 

User 
application User 

SB 118 SD Trends: Jump to 
previous segment 

User application User 
application 

User 

SB 119
SD Trends: System 
busy - Draw Trend is 
gathering data 

User application 
User 
application User 

SD Card: Data to Excel 
You can write PLC data to Excel files an the SD card using the functions Create 
Delimited Line to structure a line, and Write Delimited Line to send it to a 
specified Excel file on an SD Card. 

Note ♦ Note that the main EXCEL folder and subfolders EXCEL0, EXCEL1, 
EXCEL2, EXCEL3 can each contain 64 files, for a total of 320 .csv files. 

♦ The .csv file name cannot exceed 8 characters. It may include only
English characters and numbers: 0 - 9, A - Z, a - z, and the 
underscore character "_". 
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Create Delimited Line
Use this function to select PLC data, including numeric data and text strings, 
structure it, and save the resulting line to a vector of operands. 

 

Defining a Line 

Each row in the table displayed under Input will be a cell in the Excel line. 

1. Click the Add Row icon to open the Excel Field dialog box. 

2. Click a tab to select the type of data. 
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3. Click the Delimiter cells to select a Delimiter character that is different 
from the default. 

 

4. Add and delete row by using the icons at the top of the function 
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Type Parameter Purpose 

Source: 
Define 
Data 

Field Use this to specify data for a cell in the Excel line. 

Delimiters Control characters that delimit the data for that cell 

Target: 
Data Buffer 

SD: Start of 
Vector, 
Create .csv 
Line 

Select the operand that will be start of the vector the function uses 
to store the data selected for the line, plus its delimiters. 
Use this operand for the function Write Delimited Line 

SD: Max 
Vector 
Length, 
Create .csv 
Line (bytes) 

Sets the maximum length of the vector in bytes. 

SD: Final # 
of bytes, 
Create .csv 
Line 

Reports the actual number of bytes sent to the vector 

Status SD: Create 
.csv Line 
Status 
Messages 

This is a bitmap; a bit turns ON to indicate status. 
It  is initialized when the function starts. 

• Bit 1 - The line is truncated 
• Bit 2 - Fail to open the file. 
• Bit 3 - Fail to write the file 
• Bit 4 - SD full 
• Bit 5 - No SD card (SB [217]) 
• Bit 6 - Path not found 
• Bit 7 - Unknown error - please check SI 66 

 

Write Delimited Line
Use Write Delimited Line to pull the data from the vector used by Create 
Delimited, and use it to write to (or create) an Excel file in this folder, or in one 
of four sub-folders. 

Notes ♦ Write Delimited Line pulls data from the vector in chunks of 
512 bytes, and writes this entire 512 bytes to the SD card. 
Write Delimited line is not linked in any way to Create Delimited 
Line. In Create Delimited Line, the parameters SD: Max Vector 
Length and SD: Final # of bytes, do not influence Write Delimited 
line. 

♦ Use SB 344,Write delimited line to SD in Progress, as a condition to 
running the function. 
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Type Parameter Purpose

Source Start of 
Vector 

Use the operand that is the Start of Vector for the Create Delimited 
Line function.

Target Select SD 
folder 

This is where the line will be stored on the SD card.
You 
Values point to folders as follows: 10=the main Excel folder, 1000= 
Excel1, 1001= Excel2, 1002= Excel3, and 1003= Excel4.

File Name Either enter a name, or link an operand to provide a fi
that you MUST provide a file name. If the linked register is empty, the 
file will not be created to the SD.
If the folder does not contain a file of that name, the function will 
create one.

File 
Extension 

Select .txt or csv

Status SD: Write 
.csv Line 
Status 
Messages 

This is a bitmap; a bit turns ON to indicate status.
It 

Success Bit Turns ON when line is successfully written

SD Block Functions 
SD Data Blocks are data storage files in the SdBLocks folder on a SD card.

SD Data Blocks may reach a total of 4G, or a single Block may be up to 4G. A 
Data Block comprises Sub
you to read/write blocks of raw data between operands and these files.

SD Data Block Functions
Create SD Block 
Creates an SD Data Block in the SdBLocks folder.

urpose

e the operand that is the Start of Vector for the Create Delimited 
ne function.

is is where the line will be stored on the SD card.
u can select the folder, or provide the Folder number via register. 
lues point to folders as follows: 10=the main Excel folder, 1000= 
cel1, 1001= Excel2, 1002= Excel3, and 1003= Excel4.

her enter a name, or link an operand to provide a fi
at you MUST provide a file name. If the linked register is empty, the 
e will not be created to the SD.
the folder does not contain a file of that name, the function will 
eate one.

lect .txt or csv

is is a bitmap; a bit turns ON to indicate status.
is initialized when the function starts. 
• Bit 1 - Wrong data 
• Bit 2 - Fail to open the file. 
• Bit 3 - Fail to write the file 
• Bit 4 - SD full 
• Bit 5 - No SD card (SB [217]) 
• Bit 6 - Path not found 
• Bit 7 - Unknown error - please check SI 66

rns ON when line is successfully written

a storage files in the SdBLocks folder on a SD card.

ach a total of 4G, or a single Block may be up to 4G. A 
ub-Blocks of 512 Bytes. The SD Block functions enable 
s of raw data between operands and these files.

a Block in the SdBLocks folder.
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Create Delimited 
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Read from SD Block to Vector
Reads a specified Sub
vector that is 512 bytes long.
Write from Vector to SD Block
Writes 512 bytes from an operand vector to a specified Sub
Data Block 

Create SD Block
Use this function to: 

 Create an SD Data Block. You can cre
Block0.udb, Block1.udb, Block2.udb, and Block3.udb
Specify the number of Sub
Enlarge an existing block.

You can also specify the number of Sub
be used to enlarge the B

Parameter Purpose

SD Block number Select the Block number, 0
time. 

Sub-Blocks Use this to specify the number of Sub

Overwrite/Append If this function finds an existing SD Block of this number, you can overwrite it 
or append these Sub
adding Sub

Status Operand This MI is a bitmap; a bit turns ON to indicate status.
The MI is initialized 

• All bits OFF 
• Bit 1 
• Bit 2 
• Bit 6 

Success Bit Turns ON when the Block is created. It remains
application, or until the application calls the function.

k to Vector
ub-Block from a specified Data Block to an operand 

bytes long.
o SD Block
om an operand vector to a specified Sub

Block. You can create up to 4 SD Data Block: 
.udb, Block2.udb, and Block3.udb
r of Sub-Blocks it contains. 
block.
number of Sub-Blocks the block will contain. This may 

Block by appending Sub-Blocks. 

Block number, 0-3, or use an operand to assign a number at run 

o specify the number of Sub-blocks in the Data Block.

ction finds an existing SD Block of this number, you can overwrite it 
these Sub-Blocks. Selecting Append enlarges the SD Block by 

b-blocks. 

a bitmap; a bit turns ON to indicate status.
nitialized when the function starts. 
bits OFF – No errors, and the SD card is idle 

t 1 – The SD card is busy. 
t 2 – No SD card found, or the card is locked (Write
t 6 - Internal error 

when the Block is created. It remains ON until it is reset by the 
n, or until the application calls the function.

VisiLogic: Utilities

VisiLogic: Utilities

o an operand 
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Block: 

ontain. This may 
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Block.

you can overwrite it 
he SD Block by 

Write-enable OFF) 

t is reset by the 
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Read from Vector to SD Block

Parameter Purpose 

SD Block 
number 

Select the Block number, 0-3, or use an operand to assign a number at run time. 

Target Sub-
Block 
(location in 
Block): Vec-
>SD.udb 

The data will be written to this sub block. The number is the sequential number of 
the sub-block in the .udb file. 

Source: Start 
of Vector 
(512 bytes): 
Vec->SD 

Select the operand that is the start of the 512-byte long vector that provides the 
data that is written to the .udb file. 

Status 
Messages 

This MI is a bitmap; a bit turns ON to indicate status. 
The MI is initialized when the function starts. 

• All bits OFF – No errors, and the SD card is idle 
• Bit 1 – The SD card is busy. 
• Bit 2 – No SD card found, or the card is locked (Write-enable OFF) 
• Bit 3 .-.There are less than 512 bytes in this vector (can happen if the 

start of the vector is too close to the end of the operand address range) 
• Bit 4 – The SD Data Block number is invalid (valid numbers are 0-3. This 

error may result when using indirect addressing) 
• Bit 5 - SD card function was called while the SD is busy 
• Bit 6 - Internal error 
• Bit 7 - Data Block size exceeds 4G 
• Bit 8 - SD card is full 
•

Bits 10-13 can occur because the SD card does not have an SD_Blocks folder, or 
because a file of that name has not been created in the SD_Blocks folder. 

• Bit 10 - Can't open file/path not found 
• Bit 11 - Error while writing to a file/path not found 
• Bit 13 - Failed to close a file/path not found 
• Bit 14 - Create SD Block: Do not overwrite is selected, but the number of 

Sub-blocks is less than the number of sub-blocks already in the Data 
Block 

Success Bit Turns ON when the data is successfully written to the Block. It remains ON until it 
is reset by the application, or until the application calls the function. 
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Write from SD Block to Vector

Parameter Purpose 

SD Block 
number 

Select the Block number, 0-3, or use an operand to assign a number at run 
time. 

Source Sub-
Block (location 
in Block): 
SD.udb-> Vec 

This is the sequential number of the sub-block in the .udb file. 

Target: Start of 
Vector: SD.udb-
> Vec 

The function will write 512 bytes of data to the PLC, starting with this operand. 

Status 
Messages 

This MI is a bitmap; a bit turns ON to indicate status. 
The MI is initialized when the function starts. 
 

• All bits OFF – No errors, and the SD card is idle 
• Bit 1 – The SD card is busy. 
• Bit 2 – No SD card found, or the card is locked (Write-enable OFF) 
• Bit 3 .-.There are less than 512 bytes in this vector (can happen if the 

start of the vector is too close to the end of the operand address range) 
• Bit 4 – The SD Data Block number is invalid (valid numbers are 0-3. 

This error may result when using indirect addressing) 
• Bit 5 - SD card function was called while the SD is busy 
• Bit 6 - Internal error 
• Bit 8 - SD card is full 
• Bit 9 - Read: End Of File indication 

Bits 10-13 can occur because the SD card does not have an SD_Blocks folder, 
or because a file of that name has not been created in the SD_Blocks folder. 

• Bit 10 - Can't open file/path not found 
• Bit 12 - Error while reading from a file/path not found 
• Bit 13 - Failed to close a file/path not found 

Success Bit Turns ON when the data is successfully written to the Block. It remains ON until 
it is reset by the application, or until the application calls the function. 

SD File Functions 
You can use Windows Explorer to store any type of file onto an SD card, such 
as .html or .jpg. The SD File Functions enable your Ladder application to read 
and write these files in 'chunks' of 512 bytes. 

Note ♦ These functions can only run on files that observe the 8.3 naming 
convention; the file name cannot exceed 8 characters, and the file 
extension cannot exceed three. 
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Using SD File Functions
Each read or write operation requires 
Write, and Close File. The functions are located on SD>SD File Utilities.

Open SD File 
Note that there are separate Open File functions for both Read and Write. 
Open File must be used to activate the correct file in th
before running a read or write function.
Read Next Chunk 
Reads a specified file from a specified folder to an operand vector in 
'chunks' that are 512 bytes long.
Write Next Chunk 
Writes data chunks 512 bytes from an operand vector to a
the SD card. 

 Close File. 
There are separate Close File functions for both Read and Write.

The examples below show the functions and the System operands required to 
run read and write operations.

Read File: Example
Note the use of SBs 324, 325, and 326. These enable the Read Next Chunk 
function to continue reading data chunks until it has completed reading the 
entire file. 

ation requires three functions: Open File, Read or 
he functions are located on SD>SD File Utilities.

separate Open File functions for both Read and Write. 
used to activate the correct file in the c
ad or write function.

le from a specified folder to an operand vector in 
12 bytes long.

512 bytes from an operand vector to a

Close File functions for both Read and Write.
ow the functions and the System operands required to 
ations.

4, 325, and 326. These enable the Read Next Chunk 
ding data chunks until it has completed reading the 
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Write File: Example

Read From SD File: Open

Parameter Purpose 

Select Folder Select the folder, or use an operand to assign a number at run time using the 
following values: 
Alarms: 0  ♦ DT main folder: 1  ♦ DT1–4: 101 to 103  ♦ Log: 3  ♦ System: 4  ♦
User_app: 5  ♦ Trends main folder - 600  ♦ Trends1-4: 600 to 603  ♦ SdBLocks: 9  
♦ Excel main folder: 100  ♦ Excel1-4: 1000 to 1003  ♦ Web: 11 

File name Either enter the file name, or provide it via operand. 

File size When the function runs, this reports the size of the file, in bytes. 

Read File: Get Next Chunk

Parameter Purpose 

Read: File 
Chunk Buffer 

This the start of the vector that holds the data read from the file. This vector is 
512 bytes long. 

Read: File 
Chunk Length 

This shows the length of the chunk that is currently read. Note that the final 
chunk, containing the last of the file data, will generally be LESS than 512 bytes. 

Read File: Close
Run this when entire files has been read. 
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Write From SD File: Open

Parameter Purpose 

Select Folder Select the folder, or use an operand to assign a number at run time using the 
following values: 
Alarms: 0  ♦ DT main folder: 1  ♦ DT1–4: 101 to 103  ♦ Log: 3  ♦ System: 4  ♦
User_app: 5  ♦ Trends main folder - 600  ♦ Trends1-4: 600 to 603  ♦ SdBLocks: 9  
♦ Excel main folder: 100  ♦ Excel1-4: 1000 to 1003  ♦ Web: 11 

File name Either enter the file name, or provide it via operand. 
Note that: 
 -If the file does not exist on the SD 
 -and the SD card is Write-enabled 
the function will create the file. 

File size When the function runs, this reports the size of the file, in bytes. 

Write File: Get Next Chunk

Parameter Purpose 

Write: File 
Chunk Buffer 

This the start of the vector that holds the data that will be written to the file. The 
function takes 512 bytes of data. 

Write: File 
Chunk Length 

Enter the number of bytes to be written to the SD file. 
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Write File: Close
Run this when entire files has been written. 

 

Delete File
Use this to delete any file on the SD card 
Note ♦ These functions can only run on files that observe the 8.3 naming 

convention; the file name cannot exceed 8 characters, and the file 
extension cannot exceed three. 

♦ Use SB 358, Delete File in Progress, as a condition to running the 
function 

Parameter Purpose 

Select Folder Select the folder, or use an operand to assign a number at run time using the 
following values: 
Alarms: 0  ♦ DT main folder: 1  ♦ DT1–4: 101 to 103  ♦ Log: 3  ♦ System: 4  ♦
User_app: 5  ♦ Trends main folder - 600  ♦ Trends1-4: 600 to 603  ♦ SdBLocks: 9  
♦ Excel main folder: 100  ♦ Excel1-4: 1000 to 1003  ♦ Web: 11 

File name Either enter the file name, or provide it via operand. 
Note that: 
 -If the file does not exist on the SD 
 -and the SD card is Write-enabled 
the function will create the file. 

Status 
Messages 

This MI is a bitmap; a bit turns ON to indicate status. 
The MI is initialized when the function starts. 
 

• All bits OFF – No errors, and the SD card is idle 
• Bit 1 – SD Card internal error. 
• Bit 2 – Delete Failed 
• Bit 3 - No SD card found, or the card is locked (Write-enable OFF) 
• Bit 5– Path not found 
• Bit 7 - The SD card has failed (Check SI 66) 
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Success Bit 
 

Turns ON when the data is successfully written to the Block. It remains ON until it 
is reset by the application, or until the application calls the function. 

SD File Information 

Use this function to check if a specific file is located in a specific SD folder, and 
get specific file details. 
Note ♦ Use SB 359, File Info function in Progress, as a condition to running 

the function 

Parameter Purpose 

Select Folder Select the folder, or use an operand to assign a number at run time using the 
following values: 
Alarms: 0  ♦ DT main folder: 1  ♦ DT1–4: 101 to 103  ♦ Log: 3  ♦ System: 4  ♦
User_app: 5  ♦ Trends main folder - 600  ♦ Trends1-4: 600 to 603  ♦ SdBLocks: 9  
♦ Excel main folder: 100  ♦ Excel1-4: 1000 to 1003  ♦ Web: 11 

File name Either enter the file name, or provide it via operand. 

Status 
Messages 

This MI is a bitmap; a bit turns ON to indicate status. 
The MI is initialized when the function starts. 
 

• All bits OFF – No errors, and the SD card is idle 
• Bit 1 – SD Card internal error. 
• Bit 2 – Cannot read file 
• Bit 3 - No SD card found, or the card is locked (Write-enable OFF) 
• Bit 4– The SD card has failed (Check SI 66) 
• Bit 5 - Path not found 

Success Bit 
 

Turns ON when the data is successfully written to the Block. It remains ON until it 
is reset by the application, or until the application calls the function. 
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Rename SD File 
Use this to rename any file on the SD card.

Parameter Purpose 

Select Folder Select the folder, or use an operand to assign a number at 
following values:
Alarms: 0  ♦ DT main folder: 1 
User_app: 5  ♦
♦ Excel main folder: 100 

Old/New File 
name 

Either enter the file name, or provide it via operand.

Status 
Messages 

This MI is a bitmap; a bit turns ON to indicate status.
The MI is initialized when the function starts.

• All bits OFF 

• Bit 1 –

• Bit 2 –

• Bit 3 -

• Bit 5 -

• Bit 7 -

Success Bit 
 

Turns ON when the data is successfully written to the Block.
is reset by the application, or until the application calls the function.

SD: Cloning via Ladder 
SD Clone functions can:

Create compressed 
Upload compressed files from an SD card to a PLC.

You can 'clone' a complete PLC or data using the SD Ladder functions

These Ladder functions are parallel to the actions you can carry out via 
Information Mode. 

e on the SD card.

er, or use an operand to assign a number at run time using the 
es:
T main folder: 1 ♦ DT1–4: 101 to 103  ♦ Log: 3 
Trends main folder - 600  ♦ Trends1-4: 600 to 603 

older: 100 ♦ Excel1-4: 1000 to 1003  ♦ Web: 11

e file name, or provide it via operand.

map; a bit turns ON to indicate status.
lized when the function starts.

OFF – No errors, and the SD card is idle 

SD Card internal error. 

Rename Failed 

No SD card found, or the card is locked (Write-

Path not found 

The SD card has failed (Check SI 66) 

n the data is successfully written to the Block. It remains ON until it 
application, or until the application calls the function.

data files and store them on an SD card.
files from an SD card to a PLC.

ete PLC or data using the SD Ladder functions
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Note ♦ The SD Card password and the Clone File password must be 
identical.

♦ You can use Unitronics' SD Card Explorer, included in the SD Card 
Suite, to access SD card files and either upload them to a PC for 
viewing and editing, or transfer them into another PLC's SD card. 

This function must be used with a negative transition element. 
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Parameter Purpose 

Direction Clone To SD: Creates a compressed data file in the correct SD card folder 
Clone From SD: Installs a compressed data file from an SD card folder into the 
PLC 

File Type Select Direct or Constant. 
If you select Direct, the value in the register determines the data file that the 
function creates/installs according to the following legend: 
 2 = Full Data Table (*.fdt files) 
 4 = Firmware (*.Oxx files: .O13, .O35, or .O57) 
 5 = User Application (+VLP if exists) (*.vxx files: .V13, .V35, .V57) 
 7 - Full cloning (DT, Firmware, UA, Operands)(*.Cxx) .C13, .C35, or C57) 
 8 = Operands (*.Dxx files: .D13, .D35, .D57) 
Note that the file extension numbers relate to the Vision model: .x13 =V130, .x35 
=V350, .x57 =V570 

File Name This is limited to 8 characters. The file extension is automatically assigned by the 
PLC according to the file type. 

 If you are cloning an OS or a ‘Full Clone’, the file name MUST be exactly 8 
characters long. 

Status This MI is a bitmap; a bit turns ON to indicate status. 
The MI is initialized when the function starts. 
 

• All bits OFF – No errors, and the process is idle 
• Bit 1 –  No SD card found, or the card is locked (Write-enable OFF) 
• Bit 2 – Clone utility busy 
• Bit 3 -File type not found (*.FDT,*.Oxx,*.Vxx,*.Dxx,*.Cxx) 
• Bit 4– Incompatible Boot Version/Firmware/Clone file 
• Bit 5 - Internal use 
• Bit 6- Timeout exceeded 
• Bit 7 - - Safe to Remove Bit is ON 
• Bit 8 - Path not found (Install Clone) 
• Bit 9 - Password error 

Success Bit 
 

Turns ON when the data is successfully written to the SD. It remains ON until it is 
reset by the application, or until the application calls the function. 

SB 366: Clone in Progress. Note that the process can take from several 
seconds to several minutes. 

The following nets show the conditions required to run the function. 



VisiLogic: Utilities 

VisiLogic: Utilities 

SD: Safely Remove 
Use SD: Safely Remove to prevent the card from being physically removed 
while an SD function is in progress.

When SD: Safely Remove is called, it:

Checks to see if any SD functions are running.

If so, Safe to Remove indicates 

It allows a current task to be completed, but prevents new ones from 
starting. 

When the SD card is completely free, the Safe to Remove bit turns ON. This 
must be reset by the user.

The Status DW is a bitmap
Bits and their indications are shown in the following table. When a bit is ON, 
the related function is active.

to prevent the card from being physically removed 
n progress.

ve is called, it:

y SD functions are running.

ve indicates which function is active via the Status DW.

task to be completed, but prevents new ones from 

mpletely free, the Safe to Remove bit turns ON. This 
er.

map.
s are shown in the following table. When a bit is ON, 
ctive.
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Bit Function 
0-5 
(reserved) 

 

6 Start Saving to SD is running: SD Trend 8
7 Start Saving to SD is running: SD Trend 7
8 Start Saving to SD 
9 Start Saving to SD is running: SD Trend 5
10 Start Saving to SD is running: SD Trend 4
11 Start Saving to SD is running: SD Trend 3
12 Start Saving to SD is running: SD Trend 2
13 Start Saving to SD is running:SD Trend 1
14 HMI function Trend from SD
15 SD File Info 
16 Delete SD File 
17 Folder Report: Number of Files
18 Create Excel Delimited Line
19 SD File Utilities: SD File Write
20 SD File Utilities: SD File Read
21 SD Block Utilities: Read/Write to Block 3
22 SD Block Utilities: Read/Write to Block 2
23 SD Block Utilities: Read/Write to Block 1
24 SD Block Utilities: Read/Write to Block 0
25 HMI Variable SD Browser
26 PC Utility is communicating with SD
27 Information Mode is accessing SD
28 SD Data Table Utilities: Log DT Row
29 SD Data Table Utilities: Read from DT /Search DT for Tag or Index
30 SD Data Table Utilities: Write to DT
31 Alarm History is being logged to SD

SD Card Browser 
Placing this variable on screen enables a user to press a button to display all of 
the files in the specified folder.

Touch Screens (V570/V350): The user presses the Browse SD on
button. If file selection is enabled, the user touches files 
them. 

 Non-Touch Screens (V130): The user presses the Enter button, and 
navigates between files using the arrow keys.

SD Ladder Functions enable you to read/write data between an SD Ca
PLC memory operands, including 
data. 

You can also enable the user to delete files, or to copy the file name to an 
operand vector. You can control whether to display the Delete button by using 
the Hide Delete File MB.

Note ♦ The SD Card Browser only displays file types that are relevant for 
the requested folder. For example, when you view DT files, you will 
only be able to see .udt and .fdt files; if there are other files in the 
folder they will not be displayed.
In the Web folder, all file types are displayed
Note that in VisiLogic versions ear
cannot display .txt

D is running: SD Trend 8
D is running: SD Trend 7
D is running: SD Trend 6 
D is running: SD Trend 5
D is running: SD Trend 4
D is running: SD Trend 3
D is running: SD Trend 2
D is running:SD Trend 1
d from SD

mber of Files
mited Line
D File Write
D File Read
Read/Write to Block 3
Read/Write to Block 2
Read/Write to Block 1
Read/Write to Block 0
rowser
unicating with SD
is accessing SD
ities: Log DT Row
ities: Read from DT /Search DT for Tag or Index
ities: Write to DT
eing logged to SD
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folder.
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files. In addition, PLCs running an OS earlier than 3.0.59 do not 
support .txt display. 

SD Card and Trends 
Use the Start Saving Trend to SD to record an entire or partial trend; and Stop 
Saving Trend to halt the recording process. 
 
When the application writes this type of data to the SD card, it creates a file 
with the extension .utr in the Trends folder. Each time you start and stop 
saving the Trend, the application adds a new segment to the file. 
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Parameter 
Name 

Purpose 

Source Trend 
Number 

Click on the drop-down arrow to select a Trend in the project. 

Target SD 
.utr file 

Link an operand to provide a file name. Note that you MUST provide a file name. 
If the linked register is empty, the Trend will not be recorded to the SD. This is 
where the .udt file will be stored on the SD card. You can select the folder, or 
provide the Folder number via register. Values point to folders as follows: 1=the 
main DT folder, 100=DT1, 101=DT2, 102=DT3, and 103=DT4. 

Status 
Operand 

This MI is a bitmap; a bit turns ON to indicate status. 
The MI is initialized when the function starts. 

• Bit 1 – The SD card was formatted in an SD Tools version that is not 
compatible with the VisiLogic application in the PLC. or VisiLogic version is 
not compatible with the PLC OS. Check to see if you need to update 
versions. 

• Bit 2 – The data in the SD is not compatible with the data in the Data 
Table 

• Bit 3 .-.Data checksum error 
• Bit 4 – Failed to open file 
• Bit 5 - Failed to read from file 
• Bit 6 - Failed to close file 
• Bit 7 - In progress 
• Bit 8 - No SD card found 
• Bit 9 - SD error, check SI 66 for error message 

Success Bit Turns ON when the data is successfully written to the PLC Data Table. It remains 
ON until it is reset by the application, or until the application calls the function. 

Displaying the saved Trend 
You can display Trend curves directly from a .utr file by using the HMI element 
Trend from SD. 

Link SBs 117 and 118 with HMI buttons to enable users to jump between 
segments. Use the inverted contact of SB119 as a condition as shown below. 
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When you save a Trend to an SD card, each time you start and stop the save, another segment is 
added to the .utr file.  

# Description Turns ON : Turns OFF : Reset by: 

SB 116 SD Trends to SD: Set 
to Overwrite .utr 

User application User 
application 

User 

Use these to control the display of Trend segments on the HMI screen. Use the inverted contact of 
SB119 as a condition. 

SB 117
SD Trends: Jump to 
next segment User application 

User 
application User 

SB 118
SD Trends: Jump to 
previous segment User application 

User 
application User 

SB 119
SD Trends: System 
busy - Draw Trend is 
gathering data 

User application 
User 
application 

User 
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Data Tables 
About Data Tables 

You can store data into the Data Table memory section of your controller, then 
access the data in accordance with program requirements.  They are useful in 
implementing Program Recipes, a collection of ingredients or values that are 
used to prepare a batch of product or to perform a specific task. 

Data Tables can be used to contain parameters for pre-programmed 
recipes.Vision controllers can contain up to 120K of Data Tables (RAM); Data 
Tables (that are marked Part of Project) can take up to 192K (Flash) in 
V230/260/280/290. 

You create tables in VisiLogic, define their structure, then download them to 
the controller. Data within the tables can be copied and pasted to and from 
third-party tools such as Excel. 

You can also store Data Tables or log lines from them onto SD Cards. 

Note • Data Tables are based on bytes, not on registers.
• Data Table sections that are marked Part of Project: the data are 

downloaded with the project, and burned into the Flash memory. You 
can use this feature to preserve certain, unchanging data, such as lists 
of names or recipe data. 

• A Data Table marked as Part of Project cannot be copied to an SD 
card. 

Data tables consist of columns and rows. 

 
Creating a Data Table 

1. Open the Data Tables editor by clicking the PLC Data Tables  on the 
toolbar, or by selecting it from the Data Tables menu. 
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2. Create a table by clicking the Add Table icon, then name the table and 
define the number of columns and rows. 

 

Note • The grid that appears represents only the table's column and row 
structure. Each column in the table can contain up to 100 elements, 
such as MIs. 

3. Define a table's columns by selecting the column, then clicking the Edit 

button , or by right-clicking and selecting Edit from the Column menu. 

 
Data Table Options 
Menu 
Name 

Option 

File Import/Export 

Data Tables can be exported from an application as . upd files, then imported into 
any VisiLogic program. 

When you import the file, you can select to: 

Add individual tables to the structure. If tables of the same name already exist, the 
tables are automatically renamed. 

Delete existing tables and import the new structure. 

Memory Requirements 

Displays pie charts that show the amount of memory that will be required by the 
data tables when the project is downloaded. 

Connection All of the Connection commands require that the PLC be connected to the PC. 

Read Structure from PLC 

Imports the structure of the data tables within the PLC into the project. 
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Verify: Tables Structure 

Compares the table structure in the project to the structure of tables within the PLC.

The commands below also require that the table structure in the PLC be identical 
with the table structure in the current project. 

Read Range 

Reads the values of the selected cells from within the PLC data table into the 
project. 

Write Range 

Writes the values of the selected cells from the project data table into the PLC. 

Read Write Table 

Reads or write the values of an entire Data Table. 

Verify Cell Value: by Range 

Compares the values of the cells in the project to the values within the PLC. 

Table Table options have short-cut buttons on the left side of the Tables pane. Right-
clicking the pane also opens the Table menu. 

Add Table 

Adds a new data table. 

Edit Table 

Enables you to change the name of the data table and the number of rows and 
columns. 

Delete Table 

Deletes the entire table, both values and structure. 

Duplicate Table 

Creates a new table, including both the values and the structure of the table being 
duplicated. 

Select All 

Selects the entire table. 

Row Edit Number of Rows 
Enables you to change the name of the data table and the number of rows and 
columns. 
Insert Row 
Enables you to insert a row at any point in the table. 
Delete Row 
Enables you to delete a row from any point in the table. 
Note • Inserting or deleting a row changes the index number of all successive rows; 
impacting your data operations.  

Column Set Cell Value 
Enables you to enter values for a cell or range of cells within a column. 
Insert Column 
Inserts a column. 
Edit Column 
Enables you to name the column, set a data type for the entire column, define the 
number of elements held by each cell in the column and make other selections 
based on the data type that has been assigned to the column. 
Delete Column 
Deletes a column. 

Column Parameters (Part of Project) 
The column structure options change according to the data type selected. 
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Parameter Function 
Description Assign a unique name. 
Type A column is assigned to the data type selected. 

Data types may be directly assigned, or linked via address. 
Part of Project,
Read-only 

Select this to burn the data into the PLC's Flash memory at program download. 
You can use Part of Project to preserve unchanging data, such as lists of names or 
recipe data. 
Recommended column order 

Select this to burn the data into the PLC's Flash memory: 
At program download. You can use this to preserve unchanging data, such as 
lists of names or recipe data. 
During run-time, to preserve real-time data. In Project Properties, under the 
General tab, select Enable Write to Flash via Data Table elements. This enables 
you to use Data Table Ladder elements to store real-time data as explained in 
the topic Data Table, PLC Operands-Read/Write. 

Min/Max Enables you to set limits for the value of an element in the column. 
Format View Choose between decimal and hexadecimal. 
Number of 
elements 

A column can contain a maximum of 100 elements. 

Data Tables, Read/Write 
For information regarding Data Tables, refer to the manual VisiLogic – Utilities. 

Read enables you to copy values from a Data Table to PLC operands. 

Write functions enables you to copy operand values from a PLC to Data Tables. 
 

Read/Write functions are located on the Data Tables menu.   

Note ♦ The maximum number of operands of any type for a Read/Write 
operation is 128. 

Rows

Read Row 
Use the Read function to select Data Table rows and read their data into PLC 
memory operands. Values are read from the Data Table into the operands that 
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are linked to it in the Read function. Note that the number of rows read cannot 
exceed the number of rows that are in the Data Table. 

 

Write Row 
Use the Write function to select PLC memory operands and read their data into 
Data Table rows. 

Values are read from the PLC into the Data Table cells that are linked to it in 
the Write function. 

Note that you provide a Start Address for the PLC memory operands; the Write 
function will take a vector of operands that will fit the number of rows in the 
Data Table. 
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Writing to flash via ladder 
Columns
Note ♦ 'Part of Project' Data 

♦ Not all Data Types are supported:
Unsupported types: Boolean, Byte, String, all 'Address of'
Supported Data Types: Integer (16
bit) 

♦ When longer data types are copied to shorter data types, the longer 
values are truncated.

♦ When shorter data types are copied to longer types, each source value 
is copied to the lower bytes of the destination.

Supported Read Write 
Data 
Table 

PLC 
Operand 

Byte Integer 

Data cannot be included in Write Column
es are supported:
ted types: Boolean, Byte, String, all 'Address of'

Data Types: Integer (16-bit), Long, Float, Timer (32 

a types are copied to shorter data types, the longer 
ated.

ta types are copied to longer types, each source value 
ower bytes of the destination.

Read Write Result

1 Byte is read into the The first 8 bits of the Integer are 
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Byte Long Integer first 8 bits of Integer 
(LSB). 

written into a Byte. The last 8 bits 
of the Integer (MSB) are discarded. 

Integer Integer     
Integer Long Integer 1 Integer is read into the 

first 16 bits of a Long. 
The first 16 bits of the Long are 
written into an Integer. The last 16 
bits of the Long are discarded. 

Long 
Integer 

Integer First 16 bits of Long are 
read into an integer. The 
last 16 bits of the Long 
are discarded. 

An Integer is written into the first 
16 bits of a Long. 

Long 
Integer 

Long Integer     

Timer Timer     
Float Float     

Read Column
A column in a Data Table is the source for the Read function. Values are read 
from the Data Table into the operands that are linked to it in the Read 
function, according to FIFO. 

 

Write Column
PLC operands are the source for the Write function. Values are read into the 
Data Table cells that are linked to it in the Write function. Values are read from 
the operands into the Data Table according to FIFO. 
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Read/Write Direct
These operations access the values in the database 
structure 

Database: Read Direct 
The Read Direct operation copies data from the data tables into a vector of 
registers within the controller.

1. Select Direct: Read from the Data Tables menu.

2. Place the function in the desired net.

3. Link the desired Operands and 

Operands A & B determine the 

from the data table will be copied.

Operand A: sets the register type for the target vector and the start 

register. 

Operand B: determines the offset, in regis

Operands C, D, & E determine the 

data table the data will be copied.

Operand C: contains the start byte of the source vector within the data 

table. 

Operand D: determines the offset, in bytes, from the start

Operand E: determines the length of the source vector.

s the values in the database without reference to table 

on copies data from the data tables into a vector of 
troller.

from the Data Tables menu.

n the desired net.

erands and Addresses. 

termine the data's destination --to where

will be copied.

e register type for the target vector and the start 

ines the offset, in registers, from the st

determine the data's source --from where

will be copied.

s the start byte of the source vector within the data 

ines the offset, in bytes, from the start

ines the length of the source vector.
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Note that the length is relative to the 

A.  For example, if Operand A is linked to an MI and Operand E contains 5, 

10 bytes of data will be copied from th

into each MI. 

If Operand A is linked to a double register; ML or DW; and Operand E 

contains 2, 8 bytes of data will be copied into 2 double register.

Read Example 

Below, database bytes 28, 29, 30, 31, 32, and 33 are read a
MIs  15, 16, and 17. 

Database: Write Direct
The Write operation copies data a vector of registers into the database.

1. Select Data Block Read from the Data Tables menu.

2. Place the function in the desired net.

3. Link the desired Operands and 

Operands A & B determine the 

data will be copied.

Operand A: sets the register type for the target vector and the start 

register. 

h is relative to the type of register linked to Operand 

Operand A is linked to an MI and Operand E contains 5, 

ll be copied from the data table into 5 MIs, 

ed to a double register; ML or DW; and Operand E 

of data will be copied into 2 double register.

28, 29, 30, 31, 32, and 33 are read and written into 

ies data a vector of registers into the database.

Read from the Data Tables menu.

n the desired net.

erands and Addresses. 

termine the data's source --from which

e register type for the target vector and the start 
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Operand B: determines the offset, in registers, from the start register.

Operands C, D, & E determine the 

database the data will be written.

Operand C: contains the start byte of the source vector within the 

database. 

Operand D: determines the offset, in bytes, from the start register.

Operand E: determines the length of the source vector.

Note that the length is relative to the 

A.  For example, if Operand A is linked to an MI and Operand E contains 5, 

the data from 5 registers will be copied into 10 da

per MI. 

If Operand A is linked to a double register; ML or DW; and Operand E 

contains 2, the data from 2 double registers will be copied into 8 database 

bytes, 4 bytes per ML or DW.

Write Example 

Below, MIs 26, 27, 28, 29 are written
register is copied into 2 bytes within the database.

ines the offset, in registers, from the start register.

determine the data's destination--to where

will be written.

s the start byte of the source vector within the 

ines the offset, in bytes, from the start register.

ines the length of the source vector.

h is relative to the type of register linked to Operand 

Operand A is linked to an MI and Operand E contains 5, 

gisters will be copied into 10 database bytes, 

ed to a double register; ML or DW; and Operand E 

a from 2 double registers will be copied into 8 database 

ML or DW.

29 are written into database bytes 28 through 33; each 
bytes within the database.
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Program Recipes 
A recipe is a collection of ingredients or values that are used to prepare a 
batch of product or to perform a specific task. 

Data Tables can be used to contain parameters for pre-programmed recipes. 

For example, assume that a laundry machine performs different tasks such as 
'Fill', 'Wash' and 'Rinse'.  A Data Table is created that contains 1 row for each 
task. Each row contains cells; each cell holds a specific parameter required for 
the task assigned to that row. The parameter values are transferred into the 
cells via a Write to Data Tables function. Within the Write function, the 
operands containing the parameter values are linked directly to the 
appropriate cells. 

 

Data Tables, Excel, and .csv 
Data can be imported to and exported from Excel  and .csv files. 

Export 

Note that you can include the current values by establishing a communication 
connection with the PLC and reading or writing values from specific cells, or 
from an entire Data Table within the PLC into the Data Table in VisiLogic
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To export data 

1. Highlight the cells containing the desired data. 
Click the Export to Excel or Export to .csv button. 

2. Follow the on-screen instructions; data is exported into the desired file 
type. 

 
Import 

To import data 
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1. Click the Import to Excel or Import to .csv button. 

2. Follow the on-screen instructions; data is exported into the desired file 
type. 

The data is copied as shown below. 

 
Copy & paste data 

To copy/paste data to and from Data Tables and Excel. 

1. Select data. You can select individual cells, rows, columns, or contiguous 
groups of cells. 

2. Copy the values to the Clipboard either by pressing <Ctrl>+ <C> or by 
clicking the Copy button. 

3. Click the cursor in the Paste location, then paste the either press <Ctrl> 
+ <V> or click the Paste button. 

Note ♦ The selection is pasted towards the right and down. When you paste 
from Excel to Data Tables, the Data Table must have enough rows and 
columns to contain the Paste selection. 
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Data Table to Data Table: Copy 
These functions enable you to transfer values within the same or between 
different Data Tables. They are located on the Data Tables menu.   

Copy Rows
Select the source table and target table, and make the appropriate selections. 

 

Copy Column
Note that the columns you select must have the same structure. 

 

Data Tables: Clear, Row, Column, Table 
These functions are located in the Data Tables menu. Clear enables you to use 
a Ladder condition to delete values in a particular table. 

Clear Row
Select the desired Data Table. You can determine which row will be cleared 
either by entering the row number, or linking to an MI address containing the 
row number. 
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Clear Column
Select the desired Data Table to display its col
column will be cleared by clicking it.

Clear Table
Select the desired Data Table. When the function is activated, all of the tables 
values will be cleared. 

Data Tables: Find Row, Find Row Extended
Find Row and Find Row Extended are located on the Data Tables menu. These 
functions search through a data table, comparing the input value with the 
values in the data table.

Find Row: 
If a matching value is found, the
value. 

 
Find Row Extended:
This function enables you to search for more than one value. The number 
of the row containing all of the values is stored in the output value.

Table to display its columns. You determine which 
y clicking it.

Table. When the function is activated, all of the tables 

d Row Extended
Extended are located on the Data Tables menu. These 
h a data table, comparing the input value with the 

is found, the number of the row is stored in the output 

:
es you to search for more than one value. The number 
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Parameter 
Name 

Purpose 

Table Click on the drop-down arrow to select a table from the project, then click the 
desired column. 
The number of bytes in the column of the linked data table define the length 
of the input vector. 

Limit Rows Check this option to limit the number of rows the function will search. 

Start Address The length of the input vector is determined by the number of bytes in the 
selected data table column. If, for example, the column contains 6 bytes, the 
vector will be 3 MIs long. 
Note that a string must end with a null (0) character. 

Found Row If a matching value is found, the number of the row is stored in the output 
value. 
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Note that: 
- if the value is not found, -1 will be the value returned by the function. 
- if the row is not found, if, for example, the number given for the first row is 
higher than the number given for the last row, the value will be -2. 
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String Library 
Use String Library to store text strings within the controller's
and then display them on the controller's LCD. You can, for example, organize 
text into different String Libraries
English and Italian—pull strings into HMI objects, and then switch libraries to 
change the display language.

These strings can be displayed in the following HMI elements:

Frame 
 Button 
 Fixed Text 

String Libraries also provide the text for Alarms, and can be used in Trend 
Curve Properties. 

Note that 

 The number of libraries change
strings in each library are ‘grey'; these strings are reserved for system 
use, as for example to provide the text for Alarm screen buttons.
Each string can contain up to 128 characters.

V570/V1040/1240
Number of 
Libraries 

8 or 16 

Number of Strings 4096 
Total Library 
Memory 

64K 

* *Switching from 4 to 8 libraries downsizes the library memory 
32K to 16K.  If your library exceeds 16K you will not be able to download the 
project. 

**Switching to 16 libraries downsizes the library memory capacity to 8K.  If 
your library exceed 8Ks you will not be able to download the project. Note tha
in each library the System Strings (grey background) are preserved, and 
Strings 0-511 will be copied to the new, smaller libraries. Strings 512 and 
higher will be deleted. 

 

This feature is not available in Standard Vision controllers.

How String Library works 
Only one library is active at a time. This means that at any given time, all 
elements that pull text from a library are using the 

However, each HMI element may be linked to a 
String Library. 

In the following figure, the buttons are linked to different text lines. Each time 
a different String Library is called, the button text changes.

ore text strings within the controller's F
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Configuring Strings 
1. Click the String icon on the navigation tree or toolbar to open the Strings 

editor. 

 

2. Click on File> Rename Library to assign a unique name to the Library 

 

3. Click Number of Libraries to edit the number. 
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4. Double-click on a row to open the String Editor.
Note that the String Editor opens strings according to the ID #. In the 
following figure, the first three messages are displayed for String Libraries 
Letters_1, Numbers_2, and Symbols_3.

5. Place your cursor in the desired String Library row, and type in text. You 
can also include indirect text from an MI vector.
The text is displayed 

ow to open the String Editor.
g Editor opens strings according to the ID #. In the 
e first three messages are displayed for String Libraries 
s_2, and Symbols_3.

n the desired String Library row, and type in text. You 
direct text from an MI vector.
d in the PLC Preview window. 
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You can also break text lines by including Carriage Return + Line Feed 
characters. 

 

Note that you can find Unreferenced Strings via the binoculars icon on the 
String Library toolbar. 

Importing/Exporting Strings to/from Excel or .csv 
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These tools are located on the String Library File menu. 

 Excel: you cannot create an Excel file and import it. You must export 
a String Library from a String Library, delete any undesired 
information, and then enter your own strings. 
.csv: you must use a delimiter that does not appear within the 
string's data, or the values will not be separated according to 
expectations. 

Import/Export from Excel
1. Select all of the Strings in a Library. and then select Export 

 

2. From the File menu, select Export to Excel. 
 

3. Open and edit the Library, and then import it into any Library. 

Linking HMI Elements to Text in a String Library 
1. Place a Frame, Button, or Fixed Text HMI element. Within the element 

properties, click the String from String Library option. 
You can either link a Text ID line directly, or use an MI to indirectly 
provide the Text line ID. 

Note that the size of the HMI element must be large enough for the longest 
text line it may hold. 
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Switching Libraries 
To switch Libraries, use one of these methods: 

 Use the Ladder function Strings>Set String Library 
 Write a value to SI 491 Switch current Text Library 

 

Set String Library 
Use this function to switch String Libraries. 

 
String from String Library to ASCII 

This function, located on the Strings menu, enables you to save text from the 
String Library as ASCII. 
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Parameter  Purpose 

A The ID number of the 

B The length of the destination vector. This must be equal or greater than the 
number of character in the string

C The start of the destination vector

D Status Message
0 – Action completed successfully
1 – The Library does 
2 - The String does not exist
6 – The length of the string exceeds the length of the destination vector, 
or exceeds 128.

r of the String in the Current Library 

he destination vector. This must be equal or greater than the 
racter in the string

e destination vector

e
ction completed successfully
he Library does not exist (Library is not defined)
e String does not exist

he length of the string exceeds the length of the destination vector, 
ceeds 128.
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Web Server 
Enhanced Vision controllers can host web pages. The controller must comprise 
a TCP/IP port, and must be connected to an Ethernet network. If the controller 
contains web pages, a remote user can enter the IP address of the controller 
into a web browser and view the pages.  

You can also host complex Web pages using the program in the .zip file located 
at:http://www.unitronics.com/data/uploads/communication/WebServer.zip 

 

Ladder Application 
1. Configure Ethernet in your application by building a net that comprises the 

following elements: 

a. Com>TCP/IP> Card Init function. 
b. Com>TCP/IP>Socket Init function, set to HTTP. 

 
Selecting HTTP sets the local port to 80 and the controller to slave. 

 
Configuring Web Pages 

1. Click the Web Server Configuration icon on the VisiLogic toolbar to open 
the utility. 

2. Click in the Web Page Name field and type in a page name. 

3. You can also edit the Marquee text, which scrolls across the web page. 
The default causes the words 'Unitronics PLCs' to scroll across the page; 
clicking those words opens the Unitronics web site. You can replace the 
default text, change the website to another, or delete all of the text to 
remove the Marquee. 
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3. Select Editable if you want to enable users to edit register, counter, timer, 
and even text messages values online via the web page. Click on the 
different fields in the line to assign a Description and Operand. 
Note that the Operand type you select determines other options such as: 
Value, Timer/Counter Format, Base Format, Decimal, and Alarms and 
Warnings. 

 

Note ♦ When data is being edited, the page will not refresh.
You can also configure Alarm colors for register values by clicking in the 
Alarms & Warnings column. 
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4. Use the toolbar to add and delete line and pages. You can use the slider to 
adjust the refresh time; this controls the frequency at which values are 
updated when the page is viewed via PC. Note that you cannot display an 
ASCII string longer than 32 characters. 
 

5. Click Page>Preview Pages to check your work. 

 

When the page in the PLC is viewed via PC, the page will look as it did in 
preview mode, with the real-time values displayed. 
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Logos 
You can customize the logo via the Advanced menu. You can either import a 
logo, or link to a .url. 

 

Import/Export
You can export and import the configuration by selecting option on the Web 
Server menu. 

 

Web Page Capacity
The capacity for controllers from the V570 and V350 series is 128k. The 
capacity of the V130 series is 64K. You can check the requirements of your 
pages by clicking the Compile button and then checking Pages>Calculate 
Memory Allocation. 



VisiLogic: Utilities Web Server

VisiLogic: Utilities 77

Flickering
By default, the controller displays the web page  using AJAX technologies to 
automatically refresh variable data on the page. Note that AJAX may not be 
compatible with certain older browsers. If this applies to your application, you 
can disable AJAX by clicking it on the Web Server> Use AJAX option. 
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Trends 
A Trend graph displays a dynamically changing value graph that tracks a 
single, dynamic value such as a temperature value, as a curve on the Vision 
screen. 

Note Trends (Legacy) Function Block
If your project is configured to Standard Vision controllers that do 
not support HMI object Trend graphs, the Trend objects will not be 
displayed in the Project Navigation Window. In these models, use the 
Trends (Legacy) Function Block.   

Trends are displayed in the Project Navigation Window.  The number of Trends 
and Curves that can be displayed depends on controller model: 

 V570/V350 
Up to 8 Trends, each displaying up to 8 Curves 

 V130 
Up to 4 Trends, each displaying up to 2 Curves 

Each Curve may be linked to a different register, and can be configured to a 
different color. 

Trends have a default touch property that causes a touched Curve to be 
brought forward. In the following figure, the Temperature curve is in front. 

Touch the Mode button to toggle between: 

 Run Mode: 
Shows the Trend being drawn in real-time 

 History Mode: 
Stops the Trend, displays History Scroll buttons; touch these to scroll back 
and forth between different Trend graph sections 
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V130 

Since the V130 does not offer a touch screen, you use the Keypad arrow 
buttons to enter and navigate through History Mode 

Enter History Mode Up arrow
Exit to Online Mode Down arrow
Scroll through History Left and right arrows

Creating a Trend graph 
1. Define a Trend:  

Right-click the desired Trend to open and set Trend Properties. 

 

Property Function 

Name Assign a unique name to the Trend. 

Sampling Interval Defines how often the Trend draws Curves, 
resolution = deciseconds (0.1.) 

History Samples Total number of samples that may be 
stored in History for ALL Trends is 32000. 
 The minimum number that may be 
allocated to a Trend is 50. 
To view the total History Allocation,  
right-click Trends in the Project 
Navigation Window 

Run / Stop MB 0= Stop 
1=Run 
Status rises from 0 to 1: 

• The PLC begins to draw the Trend Curves 
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• The History is initialized 
• 'Run' is displayed at the bottom of the 

graph 
Falls 1 to 0 

• Trend freezes 
• Under can press Mode button to enter History and scroll through Trend 
• 'Stop' is displayed at the bottom of the graph 

2. Define Curves  
Right-click the desired Curve to open and set Curve Properties. 

 

Property Function 

Name Assign a unique name to the Curve for 
display on the HMI screen. 
You can also use the String Library. The 
string you select will be displayed as the 
Curve name on the HMI screen; however, 
note that the string you select will not 
appear on the Project Navigation tree. 

Data Operand This is the value represented by the Curve 

Y Min, Y Max These define the axis range for that Curve. 
Note that you can also set a decimal value. 

Once you configure a Trend and at least a single Curve, you can place the 
graph in different HMI displays and set specific properties for the Trend in that 
display, such as the Trend background color and Curve colors. 

3. Place a Trend Graph in an HMI Display 

a. Click the Trend icon on the HMI toolbar, and then drag the cursor 
across the screen to draw the Trend. 
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b. Release the mouse button, and define the Trend Variable properties.   
 

Note • Under Links, note that the Link MI shows which Curve is currently 
forward 

 V570 1= Curve 1, 2=Curve 2, etc. Therefore when the MI 
contains 3, Curve number 3 will be forward 

 V130:2=Curve 2. 1, or any other value causes Curve 1 to be 
forward 

Tab Property Function 

Appearance Points to Display Sets the number of actual points that will be shown on the 
screen at any one time 

Number of X ticks, 
Y ticks 

Set the number of gradations on the axes 
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History scroll mode Sets the paging size for History view 

Draw lines between 
points 

If this is not selected, the Curves will be drawn as a series of 
points 

X Axis Color Note that the Y Axis color always changes to match the 
Curve than is in front 

Buttons Color Sets the color for the Mode, Grid, and History Scroll buttons 

Grid Color Set the color for the background Grid 

Change current 
Curve on Touch 

Checked by default. Curves have a built-in touch property 
that causes the touched Curve to be brought forward. 

Curves Color Click to set a color 

Hide Curve if you assign a Hide Curve MB, turn it ON to hide the Curve. 

Note that the Link MI determines which curve is forward. In the case of the 
V570, touching the curve writes the curve value to the MI, bringing the 
touched curve forward. 
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Trend from SD 

Note that you can also display a Trend Curve from the Trend History that is 
stored on an SD Card. The parameters are the same as in Variable: Trend, 
given above. 

 

4. Control the Trend by toggling on the Run/ Stop MB. 
Start and stop the Trend as shown below. 

 
To learn more about Trends, check Trends - Color Vision.vlp in the Help> 
Examples. 

# Description Value Comments 

SI 63 Maximum number of 
Trend files that can be 
saved (read-only) 

0-64 
The maximum amount of 
Trend files (*.utr files) in a 
single folder is 64. The 
value in SI 63 shows the 
number of remaining *.utr 
files; if 5 *utr files exist, SI 
63 = 59 

Initialized at Power-up. 
Updated when: 
- when SB 217 is ON 
- when Trend file is created. 
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Alarms 
An Alarm is an event that is 
reported to the machine 
operator via a set of built-in 
displays. 
The event is a change in the 
Alarm’s Trigger condition, 
which may be linked to either 
a Boolean or a numeric value. 
An Alarm can: 

 Show Alarm status 
 Report the event to the 

machine operator 
 Provide instructions 
 Require operator action 
 Play an active role in the 

conditions enabling the 
running of the process 

 

In VisiLogic, you use the Alarm Configuration utility to create Alarms and set 
their features. The Ladder application determines when the Alarms are 
displayed on the controller’s screen. 

Vision controllers support Alarms according to the following table: 

Vision Type Number of Alarms Number of Alarms in History
V570 128 254
V350 64 62
V130 16 14

Alarms may be divided into up to 16 groups, per application. 

 
While the Alarms displays are on the screen, the PLC application 
continues to run. This includes both the Ladder, including 
subroutines, and the HMI application. This means that the current 
HMI display, the one on the screen when the PLC enters Alarms, 
may not be the same one displayed when the PLC exits Alarms. 

Note • This feature is not available in Standard Vision controllers.

Alarms: Ladder Application 
The Alarms displays are shown according to the Ladder application. When the 
Ladder application calls the Alarms, the displays will only appear if the Alarms 
are Active. 

The functions are located on the Alarms menu in the Ladder toolbar. 

Show Groups
This function shows the Alarms in Group display, according to the number in 
the MI Group ID to Start From. 

Note that the status MI will read 0 if no such group exists. 
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Show Alarm
This function can show a specific display for a specific Alarm. You can show the 
Alarm in the Alarms in Group display, or go directly to the Alarm Details or 
History. 
 

Clear History Buffer
Use this function to erase the Alarm History. 
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Information Mode 
Information Mode is a utility that is embedded in the operating system of the 
controller. Via Information Mode, you can view data on the LCD screen, use 
the controller’s keyboard to directly edit data, and perform certain actions such 
as resetting the controller.  You can enter Information Mode at any time 
without regard to what is currently displayed on the LCD screen. 

 

Viewing data does not affect the 
controller’s program. Performing 
actions, such as initializing the 
controller, can influence the 
program. 
 
Note that when you use Information 
Mode, the keyboard is dedicated to 
that purpose. The keys return to 
normal application functions when 
you exit Information Mode. 

Entering Information Mode 
1. To enter Information mode: 

-Non-touchscreen models: press the <i> key on the Vision’s keyboard. 
 
-Touchscreen models: touch the screen in an area that is not occupied 
by a Keypad Entry variable or other screen object that has been assigned 
a Touch Property. Maintain contact for several seconds 

2. The controller enters Information Mode and requests a password. 

3. Enter your password.  The default password is 1111.  Note that at every 
power-up, this password is restored. To maintain a different password 
after power-up, use SB 2-Power-up as a condition to store the desired 
password value into SI 253. 
To change the password, access the controller via VisiLogic, then run On-
line Test mode and changing the value. This value will be erased at 
power-up. 

4. The controller enters Information Mode, showing the first category, Data 
Types. Use the <Enter> key to enter a category. 

5. Press the <ESC> key to exit a category, and to exit Information mode. 
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Notes 
•

When you reenter Information Mode, the controller will return to the 
last Category viewed.

Info System Operands 
# Description Turned ON
SB 36 INFO mode Turns ON when 

Info Mode is 
entered by OS, 
Remote 
or program

# Description Value 
SI 50 INFO Mode: 

Entry Delay 
Time 

Default by O/S 
(every power up) 
= 4 seconds

SI 
253 

Password: 
Info Mode 

Note that at every power
1111, is restored. To maintain a different password after power
use SB 2
value into SI 253.
The password may also be modified by 
VisiLogic, then running On
This value will be erased at power

The categories of available information depend on the controller model. The 
table below shows the basic categories o

Category Subject 

The controller will block 
entry into Information mode 
until the correct password 
has been entered. 
why you must record any 
password you set for your 
controller. 
The data in Information 
Mode is arranged in 
Categories.  
contains several Subjects. 
You navigate Information 
Mode by using the keyboard 
buttons. 
To exit Information mode, 
press the <ESC>button on 
the Vision’s keyboard. 
press returns one level up. 
Press the number of times 
necessary to exit. 

er Information Mode, the controller will return to the 
wed.

ed ON Turned Off Comments 
ON when 
ode is 
d by OS, 
e Access, 
gram

Turns OFF when 
user exits Info 
Mode 

Delay time to enter Info Mode is 4 
seconds, may be modified via SI 50

Comments 
by O/S 
ower up) 

onds

� Units: seconds. 
� Legal values: 0, 3 to 20. 
� If you force or store '0' into equal Zero 

disabled. 
� For V290 – Touching the <i\>

screen starts Info Mode – Touching a legal Ladder 
application variable clears the INFO time.

at at every power-up, the default password to Info Mode, 
s restored. To maintain a different password after power
2-Power-up as a condition to store the desired password 

nto SI 253.
ssword may also be modified by accessing the controller via 
ic, then running On-line Test mode and changing the value. 
lue will be erased at power-up. 

e information depend on the controller model. The 
sic categories of information. 

Possible Actions 
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Data Types Memory Bits • View bit status 

System Bits • Change bit status (Set/Reset) 

Memory Integers 

System Integers 

Memory Longs 

System Longs 

Memory Double 
Words 

System Double 
Words 

• View integer/long integer/double word value. 

• Change values 

• Toggle Base: view the value in decimal or 
hexadecimal form. 

Inputs • View input status. ·
• Force input status to 1 (FR1) or  0 (FR0).  Forced 

values stay in effect until Normal mode (NRM) is 
selected, or until the controller is initialized or 
reset.   
Note • Forced values do influence your program. 
This can be useful in testing the effect of an input 
condition on an output status. 

Outputs • View output status. ·
• Force output status to 1 (FR1) or  0 (FR0).  Note 

that forced output values do not affect your 
program. 

• Set/Reset output status. 

Timers • Enter a Preset Timer value. 
• View the current timer value and status by 

selecting the R.T. option. 

TCP/IP (Standard 
Vision, Visible when 
Ethernet card is 
installed) 

Enables you to view and edit IP address and socket 
settings. 

System Model & O/S Ver • Check the controller’s model number and operating 
system version. 

• Check whether the controller is in Run or Stop 
mode. 

Working Mode • Check whether the controller is in Run or Stop 
mode. 

• Reset the controller. This restarts your program; 
restoring power-up values to all data types except 
for those protected by the battery backup. The 
battery protects Real Time Clock (RTC), all 
operand, and Data Table values. 

• Initialize the controller. This restarts your program 
and initializes all values, restoring 0 values to all 
data types. 
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Time & Date • View the Real Time Clock (RTC) settings.  Note 
that the RTC settings control all time-based 
functions. 

• Change the RTC settings via the controller’s 
keyboard. 

Unit ID The Unit ID number identifies a networked controller. You 
can: 

• Change the ID number.  The new ID number will 
remain in effect until the controller is reset. 

• Burn the ID number into the controller’s FLASH 
memory. This is a permanent change. 

Serial Port 1 
Serial Port 2 

• View and edit communication settings. 
• Select to Change or Burn the new settings. 

Ethernet (Enhanced 
Vision, if an 
Ethernet card is 
installed) 

Enables you to view and edit IP address, Socket settings, 
and other TCP/IP settings. 

Monitor 
Communications 
(Enhanced only) 

This is a built-in communications 'sniffer' 
• Touch screen models: select Serial or Ethernet, 

then press Monitor. Note the button that allows 
you to toggle between Hex and ASCII 

• Non-touch screen models: Select Communication, 
then select Serial or Ethernet> COM Buffer. Use F2 
to toggle between Hex and ASCII. In addition, 
press Enter, and then the Down key to toggle 
between. Tx and Rx. 

CANbus • Built-in CANbus communications 'sniffer' 
• Change the CANbus baud rate. 

Touchscreen 
(Touchscreen 
models only) 

Enables you to calibrate the touchscreen, if it is not 
responding accurately to screen taps. 

SD Card 
(Enhanced 
Division) 

Removable 
memory storage 

Enables you to upload and download VisiLogic applications, 
OS firmware, and Data Table data from/to an SD card. 
You can use these features to 'clone' a PLC application. 

Function 
Block 

Reserved for future 
use 

Hardware 
Configuration 

• Check if I/O Expansion Modules are installed.  Note 
that I/O Expansion Modules are represented by 
letters.  Identical module types are represented by 
identical letters as shown below. 

• Shows if an I/O module is short-circuited. 
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Remote Access: Accessing a PLC via PC 
Use VisiLogic to activate access a remote Vision controller and: 

 Download and upload projects 
 Remotely operate the controller's HMI through your PC 
 Run On-Line Test mode on the remote controller 
 Run Information Mode. 

You can access: 

 Stand-alone controllers that are directly connected to the PC via a cable. 
 Controllers within a CANbus or TCP/IP network 
 Either stand-alone or networked controllers via GSM or landline modem. 

 

Note • In addition to using VisiLogic to access a remote Vision, Unitronics 
provides a stand-alone utility called Remote Access.  This utility can 
also access Unitronics M90/91 and Jazz controllers. It may be freely 
downloaded from http://www.unitronics.com. 

Accessing a PLC via VisiLogic 
Before you can access a controller, you must establish a communication link: 

Direct Connection: PC-Controller
1. Connect your PC to any controller using the programming cable supplied 

with the controller kit.
In the case of the V1040, the USB cable may be used; note that COM port 
1 function is suspended when this port is physically connected to a PC 

http://www.unitronics.com/
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Accessing a Networked Controller
2. Connect your PC to any controller in the network using the programming 

cable supplied with the controller kit. 

 
Note • Different PCs can access a network at the same time, using different 

controller units as bridges. However, 2 different PCs cannot 
simultaneously access the same controller unit. 

3. Select a networked controller by opening Communication & OS from the 
Connection menu, and then entering the Unit ID number. 
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Accessing a Controller via Modem 

1. Prepare and connect your PLC-side modem as described in the topic PLC-
side Modems, in the section 'How to enable a controller to communicate 
via landline, GSM/GPRS modem'. 

2. Prepare the PC-side modem as described in the topic PC-Side Modems 
(Modem Services), in the section 'How to Configure a PC-side Modem'. 

3. Via Connection>Modem Services, dial the remote PLC's controller to 
establish the data link. 

4. Select a connection type using the drop-down selection box on the 
toolbar. 

 
5. Click the On-line Test mode button or press <F9> to enter On-Line Test 

mode; the left Ladder rail turns red and real-time values are displayed in 
the Output window. 

6. Click the Remote Access button on the On-line Test toolbar to display the 
remote controller on your PC screen. You can toggle the controller image 
on and off using <Shift>+<F9>. 

 

7. Remotely operate the controller's HMI by using: 
- Your PC keyboard, pressing arrow, alphanumeric, and function keys 
<F1> to <F8>). Note that the Vision <ESC> key is the <E> key on the 
PC keyboard 
- Your mouse to click keypad keys on the Remote Access image on the PC 
screen. In the case of touch-screen models, you can also click on-screen 
objects. 
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To enter Information Mode, press the <i> key on your PC keyboard, or by 
clicking it on-screen with your cursor. 

 

Remote Access options
Use the options to set display options and refresh rate. 

 
Note • The Zoom option can be activated only if you select Hide Keys. Zoom 

cannot be used with or V280 controllers. 
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Improving Remote Access run times:
Cache files enable Displays to load more quickly. These files enable Remote 
access to refer to HMI elements stored in the PC, instead of taking them from 
the PLC. If you have been provided with a static HMI file, select it to improve 
Remote Access run times. 

Monochrome Vision only 

 To use a temporary memory cache during a session, select Project> 
Cache from the Build menu. 

 The HMI cache files are in .ura format. To create a .ura file containing 
static displays, select Export Displays to 

 
Color Vision only 

The static HMI files are in .urc format. Such files can be created in Remote 
Access by selecting the option Create Fonts and Images (*.urc) from PLC 
shown in the following figure. The .urc file may include either fonts, images, or 
both. However, note that if the .urc file does not include graphics, Remote 
Access will not display images. 

 
Note • When Remote Access creates a .urc file, the Vision enters 'System 

Mode'; the PLC continues running while displaying a system image. 
The HMI application is not visible. 
In addition, note that an interruption in communications may leave 
the PLC inaccessible. In this case, the PLC may require reset, which 
requires an operator to be physically present near the PLC. 
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Creating Project files (Clone files) 
Project files contain application data in compressed format *.dvi, *.vdf *.urc, 
and *.ura. There are several kinds of files. 

 Clone Files: 
These can contain complete applications in compressed format, including 
Ladder and HMI applications and OS. Clone files are very convenient for 
OEMs, or for those wanting to 'Clone' a PLC and its application. These files 
can be created in VisiLogic as well as via SD Clone Ladder functions or in 
Information mode. 

 Project Files: UniDownloader Designer 
These files include both the Ladder and HMI applications, Data Tables, and 
an Upload file. 
-Standard Vision: .dvi files 
-Enhanced Vision: .vdf 
 Note that the DownLoader files you create here are compatible with 
UniDownloader 4.0.0 and later; provide your users with the correct 
UniDownloader version. 

 Cache files: Remote Access and Remote Operator 
These are compressed HMI Displays. They improve Remote Access 
reaction times, and must be used to display graphic images when using 
Remote Operator. 
- Monochrome Vision (.ura files) 
A .ura cache file enables Remote Operator to load Displays more quickly. 
Note that V130, which loads displays quickly, does not use .ura files.) 
- Color Vision (.urc files). 
 If a .urc is not used, images are not displayed and fonts may be 
distorted. 

 A cache file includes fonts, and can include images.  
 If the file does not include images, a red 'X' displays in place of 
graphics. 

To create Project files: 

1. Click on the Project menu and select Create Project files. 

2. Select the appropriate tab and follow the on-screen directions. 



VisiLogic: Utilities Creating Project files (Clone files)

VisiLogic: Utilities 99

Notes • .cxx Files

PLC Unique ID 
Each PLC has a unique ID number, which is shown in SDW9. 
Use this number to restrict a program to a particular PLC. 

 Password: 
This is assigned to the SD Card via the Set SD Card Password 
function. 
 

• Both the controller you use to make the download file (source), and 
the controller that is installed with the file (target) should be installed 
with the same OS Version. 

• To avoid errors in the file, the creation process must run smoothly, 
without being aborted or affected by PC faults. 

Checking the integrity of the .dvi file
Although you do not need to have Remote Access installed on your PC in order 
to create .dvi files, you need to install it in order to check .dvi files. 

1. After you have created the .dvi file, save the project from which it 
was downloaded. 

2. Open a new, empty project and download it to the controller. 

3. Start Remote Access and select the appropriate Vision model. 

4. Click on the Project Downloader which is located on the Remote 
Access Tools menu. 

5. Navigate to the .dvi file and download it into the controller.   
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6. Reopen the original Ladder project used to create the .dvi file. 

7. Select Verify from the Controller menu; the Verify process will 
compare the project in your PC with the .dvi application installed in 
the controller. 

If the Verify process is successful, the .dvi file is valid. 

UniDownloader Designer 
The UniDownloader package enables you to build a complete, compressed 
project and send it anywhere to be installed in a PLC using a standalone 
downloader. Your end user will be able to download the application, but will not 
be able to view or modify it. The tool can download applications and OS. 

The package comprises the UniDownload Designer, located on the Tools menu, 
and the UniDownloader, available as a separate download from 
www.unitronics.com. 

To learn about UniDownloader, click on the Tools menu in VisiLogic, U90 
Ladder, or Remote Access, select UniDownloader Designer, and then access 
the UniDownloader Designer Help. 
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PTO Functions: Simple Motion Control 
You can implement motor control by controlling the high-speed outputs of 
certain Vision controllers using PTO functions, controlling up to three 
independent axes. 

In this way you can, for example, build speed profiles that are appropriate for 
stepper motors. Note that the PTO control functions are open-loop, and do not 
rely on positional feedback. 

Supported Modes: 
Pulse 
Uses a single high-speed output 

 Pulse + Direction 
Uses 2 high-speed outputs, one for the pulse, and the second to control 
direction 

 Clockwise/Counter Clockwise 
Uses 2 high-speed outputs, one for clockwise, the other for counter-
clockwise 

 
Channels and Outputs

A Channel comprises the outputs that are required to implement a Mode. 

The number of channels, the possible modes, and the outputs used to 
implement them vary from model to model. The following tables show the 
possible combinations, according to Vision model. 

Notes • When an Output is not being used in a channel, it may be used as 
a general-purpose output (not high-speed) 

Caution These functions are based on programming logic, and therefore 
do not have the safeguards generally provided by electro-
mechanical controls. It is the user's responsibility to implement 
those safeguards required by his system, such as override and/or 
emergency stop mechanism.  

V130/V350-TR34 

Channel Possible Mode Combinations 
Channel 0 Pulse Pulse + 

Direction 
Pulse + 
Direction 

Pulse Clockwise/Counter 
Clockwise 

Channel 1 Pulse Pulse + 
Direction  

Pulse Pulse + 
Direction 

Disabled 

Channel 2 Pulse Disabled Disabled Pulse Pulse 

Channel Output  used per Channel 
Channel 0 Pulse (O0) Pulse (O0) 

+
Direction (O2) 

Pulse (O0) 
+
Direction (O2)

Pulse (O0) Clockwise (O0) 
/
Counter Clockwise (O1) 

Channel 1 Pulse (O1) Pulse (O1) 
+

Pulse (O1) Pulse (O1) 
+

Disabled 



PTO Functions: Simple Motion Control VisiLogic: Utilities

2 VisiLogic: Utilities

Direction (O3) Direction (O3)
Channel 2  Pulse (O2) Disabled Disabled Pulse (O2) Pulse (O2) 

V130/V350-TRA22 

The following table shows all of the possible PTO mode combinations for this 
model. 

Channel Possible Mode Combinations 
Channel 0 Pulse Pulse + 

Direction 
Pulse + 
Direction 

Pulse Clockwise/Counter 
Clockwise 

Channel 1 Pulse Pulse + 
Direction  

Pulse Pulse + 
Direction 

Disabled 

Channel Output  used per Channel 
Channel 0 Pulse (O0) Pulse (O0)

+
Direction (O2) 

Pulse (O0)
+
Direction (O2) 

Pulse (O0) Clockwise (O0)
/
Counter Clockwise (O1) 

Channel 1 Pulse (O1) Pulse (O1)
+
Direction (O3) 

Pulse (O1) Pulse (O1)
+
Direction  (O3)

Disabled

V130/V350-TR20, TR6 

Channel Possible Mode Combinations 
Channel 0 Pulse Pulse + Direction Clockwise/Counter Clockwise 
Channel 1 Pulse Disabled Disabled 

Channel Output  used per Channel 
Channel 0 Pulse (O0) Pulse (O0)

+
Direction (O1) 

Clockwise (O0)
/
Counter Clockwise (O1) 

Channel 1 Pulse (O1) Disabled Disabled

PTO Configuration 
In this function you select a Vision model, which determines the available 
Channels and Modes. Those not available are disabled.  
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Parameter 
Name 

Purpose 

Vision Model Select the appropriate model 
Channel A Channel comprises the inputs used to carry out the PTO function, and 

determines their function 
Mode The possible modes are: 

• Pulse  
• Pulse + Direction  
• Clockwise/Counter Clockwise  

The tables in the previous section give all possible combinations and output 
assignments, based on model. 

Switch Switch reverses the tasks of the PTO outputs that are assigned to the channel in 
modes Pulse + Direction or CW/CCW. This can be helpful to fix cases where the 
output wiring is reversed.  

Unit PTO functions rely on Units. This is where you determine the number of pulses per 
Unit. 
Note that neither values for Unit nor Pulses per Unit may exceed 1000 
Note -  To control your output using straight frequency,  set  1 pulse = 1 unit. 
 Calculate Frequency to Units according to the following 

 
Status 
Messages 

0 - No error 
1 - Invalid configuration data 
2 - VisiLogic/OS mismatch; this OS version 
3 - Vision outputs do not support function 
4 - Invalid structure 
5 - Invalid configuration channel 
6 - Unit or Pulse per Unit exceed limits (1-1000) 
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7 - Channel already initialized 
8 - Currently in motion ( function cannot be performed during acceleration or 
deceleration) 

Success Bit Turns ON when the Status MI =0 

Set Profile 
Use Set Profile to define the motion profile for a particular Channel in the 
configuration. 

 

Ranges
Note the minimum and maximum ranges for your motion profile. 

Minimum Maximum
5 Hz 15 kHz
10 Hz 20 kHz
305 Hz 133 kHz
610 Hz 200 kHz

Parameter 
Name 

Purpose 

Channel Select the relevant channel 
Start/ Stop 
Velocity 

These parameters determine the limits of the motion profile for the channel. 
Note that the resolution of velocity is according to the units set in the PTO 
Configuration.  
 

Maximum 
Velocity 
Acceleration 
Time 
(mS) 
Deceleration 
Time 
(mS) 
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Jerk Factor Controlling for jerk influences the shape of your motion curve. 
Legal values are from 1 to 16, where 1=trapezoidal curve and 16 =perfect S. 

Status 
Messages 

0 - OK 
1 - Invalid configuration data 
2 - Currently in motion ( function cannot be performed during acceleration or 
deceleration)  
3 - Invalid channel 
4 - PTO Configuration block does not exist 
5 - Out of range  
6 - Maximum value is out of range 

Success Bit Turns ON when the Status MI =0 

PTO Move 
In this function you determine the parameters of movement.  

 

Parameter 
Name 

Purpose 

Channel Select the relevant channel 
Movement 
Type  

This sets the type of movement: 
• Absolute Position 

This causes movement to the exact position requested, without 
considering the current position.  

• Relative Position 
Here the movement is relative to the current position. 

Velocity  Note that the resolution of velocity is according to the units set in the PTO 
Configuration 

Target Position Sets the desired goal 
Status 
Messages 

0 - Idle / OK 
1 - Configuration data is invalid 
2 - Invalid channel 
3 - Channel not initialized, or Vision outputs do not support function 
4 - Absolute Movement cannot be performed 



PTO Functions: Simple Motion Control VisiLogic: Utilities

6 VisiLogic: Utilities

5 - Currently in motion ( function cannot be performed during acceleration or 
deceleration) 

Success Bit Turns ON when the Status MI =0 

PTO Stop 
Use this to stop movement   

 

Parameter 
Name 

Purpose 

Channel Select the relevant channel 
PTO Stop • Immediate 

Intended to cause an immediate, emergency stop with no regard for 
position or any other parameter (requires parameter reset) 

• Normal 
Stops motion according to the rate of deceleration set in the PTO 
Configuration. 

Status 
Messages 

0 - Idle / OK 
1 - Already stopped 
2 - Invalid channel 
3 - Channel isn’t initialized 
4 - unknown command 

Success Bit Turns ON when the Status MI =0 

Read Status 
Use this to ascertain the current position.  

 

Parameter 
Name 

Purpose 

Channel Select the relevant channel 
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Current 
Position  

Use these as a reference for Move functions 
 Note that the resolution of velocity is according to the units set in the PTO 
Configuration Velocity 

In Progress This turns Off after the values have been read. 
Status 
Messages 

0 - Idle / OK 
1 - Currently in motion ( function cannot be performed during acceleration or 
deceleration) 
2 - Channel is not configured 
3 - Invalid channel 
4 - Read Timeout 

Success Bit Turns ON when the Status MI =0 

PTO Set Home 
Use this to set a Home position for Move operations set to Absolute Position 

 

Parameter 
Name 

Purpose 

Channel Select the relevant channel 
Offset: PTO Set 
Home 

The channel uses this value to set the reference point for the next move 
operation. If, for example, the Absolute target is set to 600, and the Offset to 
200, the channel will move to 400. 

Status 
Messages 

0 - OK 
1 - invalid channel 
2 - precondition error 
3 - Channel is currently accelerating or decelerating ( Movement can only be 
performed when system is Idle of in steady state) 

Success Bit Turns ON when the Status MI =0 
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Unitronics' Standalone Software Utilities
These utilities can be freely downloaded from 
http://unitronics.co.il/Content.aspx?page=Downloads. 
 
SD Card Suite 

The SD Card Suite contains several applications that you need to work with SD 
cards: 

 Tools 
Includes the Card Formatter (note that a card must be formatted 
before use), the HTML Compiler for webpages served from the SD, and 
the Fill Time Calculator which enables you to determine how long your 
application will take to fill up the SD Card. 

 SD Card Explorer 
Use a PC to access, read and write files on an SD Card that is installed in 
a Vision controller 

 SD Card Manager 
Import SD files: Trends, Logs, Alarms, and Data Tables, view them, and 
export them to Excel or .csv files. 

 Data Tables Editor 
View, export, and edit Data Table files. 

 

http://unitronics.co.il/Content.aspx?page=Downloads
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SD Tools (Card Formatter, HTML Complier, Fill Time Calculator) 
Click a tab to access the desired tool. 

SD Card Format
A Unitronics PLCs can only work with an SD Card that is correctly formatted. 

To format the card: 

1. Place the card in an SD 
card reader and plug 
the reader into a 
computer’s USB port. 
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2. Open SD Tools and 
select SD Card Format. 

3. Select the drive that 
holds the SD card. 
Enter a name for the 
card, and then click 
Start.  

3. The SD Card Formatter displays a message, warning you that the process 
erases all card data; click OK to begin the formatting process. 

4. When it is complete, the application shows the File System as FAT 32, 
and shows the total capacity and the amount of free space on the card. 

6. View the card in 
Windows Explorer. The 
Formatter creates a 
directory structure 
which the PLC uses to 
write files to the SC 
card 

 The SD card is now ready to 
insert into the PLC. 

 
7. To insert the SD card into 

the PLC, locate the SD 
card slot on the controller. 
The slot is located on the 
side of models V130, V350, 
V1040, and on the top of 
the V560 and V570. 
Press the card down lightly 
until it clicks into place. 

 

V130/350/V1040 V560/V570

Once you have formatted the card, you may want to calculate its capacity in 
accordance with your application demands. 

Calculator: Time to Fill SD
This enables you to determine how long your application will take to fill up the 
SD Card. 

To use the Calculator, check the relevant elements. This enables the text 
boxes that allow you to enter parameters or select options. 

 Data Tables: Remember that using the Overwrite option causes the same 
section of card to be reused; therefore the card will not fill up. 
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HTML Compiler 
The complex webserver application available from 
http://www.unitronics.com/Content.aspx?page=Third-party_Utils streams data 
in packets that are 512 bytes long. To prevent values from being chopped off, 
run your pages through the HTML Compiler. 
Click on the HTML Compiler tab, and follow the on-screen directions.  
 

SD Card Explorer 
SD Card Explorer enables you to use a PC to access an SD Card that is 
installed in a Vision controller. The controller may be directly connected to the 
PC, or remotely located. 

Once you establish PC-PLC communications, you can: 

 Read files from the SD to the PLC 
 Write files from the PLC to the SD 
 Delete files from the SD 

 
To begin using SD Explorer: 

1. Open it from SD Card Suite, and then click Click Settings. 
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2. Select the Connection type, and then set the communication parameters. 
 

Parameter Purpose
Connection Type Select Ethernet or Serial. The communication parameter 

options will change accordingly. 
Fill in the parameters according to your requirements. 

PLC Name This is required. If a name has not been assigned, you can 
use the default name in Information Mode (Located in 
Information Mode under Version> Software) 

3. To access the SD Card, click Open; Explorer builds a list of SD Card 
contents. 
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4. Use the toolbar icons to read files from and write files to the SD Card. 
Clicking the Backup button starts a wizard that enables you to copy the 
entire card contents to a PC drive. 
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Note that you can double-click on Data Table files to open them up in the Data 
Table Editor. 

SD Card Manager 
SD Card data table, trend, and log files are in a format that can only be read 
by a PLC and must be converted to a user-friendly format using the SD Card 
Manager. 

Before you can do this, you must copy the files to a PC.  

If the files are on an SD Card that is installed in a Vision, you can copy them to 
your PC using the SD Card Explorer. 

 If the SD Card is connected to your PC's USB port, open SD Card Manager, 
select Import Folder and follow the wizard's directions. This process copies the 
Alarms, DT, Log, and Trend folders onto your PC hard drive. 
 

You can now click a file to view it within the SD Card Manager, or you can 
export it to Excel/.csv. 

 



VisiLogic: Utilities SD Card Suite

VisiLogic: Utilities 15

Data Table Editor 
You can use the Data Table Editor to work with .fdt and .udt files.   

1. Click Open, and navigate to the desired folder. 

2. Select cells, and use the toolbar buttons to export and edit values. 
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Remote Operator 
Remote Operator enables you to use a PC to view and work with a remote 
controller's HMI panel. 

You can define any number of controllers, then open multiple sessions to view 
them simultaneously, while docking or cascading windows according to your 
preferences. 

During a session, the remote controller is displayed, on-line, on your PC 
screen. You can ‘press’ keypad keys and touch-screen objects of: 

 Stand-alone controllers that are directly connected to the PC via a cable. 
 Controllers within a network. 
 Devices with IP addresses, via Ethernet. 

This utility can be used with Vision, M90/91, and Jazz controllers. Enhanced 
Vision controllers require O/S versions 5.00 and higher; other series are 
compatible regardless of OS version. 

Using Remote Operator

Define the PLC
By default, Remote Operator opens with a single PLC named Remote PLC, 
defined by default as directly connected to your PC using the programming 
cable supplied with the controller kit. 
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1. To define the PLC, click the Communication Settings icon. 

 
2. Under Connection Type, use the drop-down arrow to select Ethernet or 

Serial. The communication parameter options will change accordingly. 

3. Fill in the parameters according to your requirements. If you are accessing 
a PLC in a CANbus/RS485 network, enter the Unit ID number. Connect 
your PC to any controller in the network using the programming cable 
supplied with the controller kit.

Note ♦ Different PCs can access a network at the same time, using 
different controller units as bridges. However, 2 different PCs 
cannot simultaneously access the same controller unit. 

4. If you are accessing a Vision PLC, enter the PLC Name. This is required for 
Vision PLCs only. 
Note that you can save these definitions to Favorites, by clicking the 
Favorites bar and selecting the first icon. 

5. Test the connection by clicking the Check Connection button. 
Note that you can change the default name by right-clicking it. 
 



Remote Operator VisiLogic: Utilities

18 VisiLogic: Utilities

Cache Files (Vision only) 
 

When you use Remote Operator to access monochrome Vision controllers, 
you will always see both the images and the text that are in the HMI 
application. 
However, if you are accessing color Vision controllers, you will see only text. 
In order to see the images, you must use a .urc file that contains images. 

.ura and .urc: HMI cache files (Vision only) 

HMI cache files enable Remote Operator to refer to HMI elements stored in the 
PC, instead of taking them from the PLC. 
 

Monochrome Vision 
A cache file enables Remote Operator to load Displays more quickly.  
The HMI cache files are in .ura format.   
(note that V130, which loads displays quickly, does not use .ura files.) 
 
Color Vision 
If a cache file is not used, images will not be displayed and fonts may be 
distorted. 
A cache file includes fonts, and can include images. However, note that if 
the file does not include images, Remote Operator will display a red 'X' in 
place of graphics. 
The HMI cache files are in .urc format.  
Such files can be created in Remote Operator by selecting the option 
Create Fonts and Images (*.urc) from PLC. 
 

Note ♦ When Remote Operator creates a .urc file, the Vision enters 'System 
Mode'; the PLC continues running while displaying a system image. 
The HMI application is not visible. 
In addition, note that an interruption in communications may leave 
the PLC inaccessible. In this case, the PLC may require reset, which 
requires an operator to be physically present near the PLC. 
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Other options

Show Case:Select this to hide or display the PLC enclosure around the Display 
screen. 
Refresh: Select to assign a display refresh rate or opt for Manual refresh. 

Background Color: This will provide the background color in the window 
displaying this PLC 

Interpolation Mode: Different modes may display differently on your PC 
screen 

Save Sessions
You can save a Remote Operator session as a file. 

1. Open Remote Operator, and define PLCs together with their 
communication settings. 

2. Click Save on the toolbar. Enter a name for the Session, and then click 
Save. 

 
Once you have configured Remote Operator, enter Online mode by clicking 
Run. 

 

In this mode, you can: 

 Use your cursor to operate the controller keypad and activate touch-
screen objects (relevant models). 

 Use your PC keyboard to operate the controller keypad (numeric keys, 
function keys <F1> to <F8>). Note that the Vision <ESC> key is <E> on 
the PC keyboard. 

 Enter Information Mode by pressing the <i> key with your cursor. 
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Remote Access 
Remote Access enables you to use a PC to access a remote controller. During a 
Remote Access session, the remote controller is displayed, on-line, on your PC 
screen. You can ‘press’ keypad keys and touch-screen objects, check system 
status and run-time values, as well as test and troubleshoot problems in 
remote controllers and applications.  You can access: 

 Stand-alone controllers that are directly connected to the PC via a cable. 
 Controllers within a network. 
 Either stand-alone or networked controllers via GSM or landline modem. 
 Devices with IP addresses, via Ethernet. 

 

The Remote Access package includes additional utilities: 

 UniDownloader Designer 
 Operand Access 
 Data Tables 

Remote Access can be used with Vision, M90/91, and Jazz controllers. Vision controllers 
require O/S versions 2.96 and higher; M90/91 require V3.00 and higher. 
 

Using Remote Access 

Selecting an OPLC model
Select the controller model from the Configuration menu. 
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Note ♦ Vision model controllers:
Select the model. If the controller is in a network, open 
Communication-PC Settings from the options menu, and select the 
controller's ID number. 

♦ M90/91model controllers within a network:
Select which type of network, and then select the controller's ID 
number. 

♦ Located on the Configuration menu. Auto-reconnect causes Remote 
Access to automatically attempt to renew a broken communication 
link. When you select Auto-reconnect, messages signaling broken 
communication links are suppressed. 

After you select the model, access the controller according to the connection 
type: 

 Communication-PC Settings for direct PC-PLC connection, networked 
controllers via bridge, or TCP/IP 

 Modem Services for landline and cellular modems 
 

Note ♦ When you use Remote Access to access monochrome Vision 
controllers, you will always see both the images and the text that 
are in the HMI application.  
However, if you are accessing color Vision controllers, you will see 
only text. In order to see the images, you must use a .urc file that 
contains images. 

Once you have established a communication link according to the connection 
type,, you can click the OnLine icon to enter Test (Debug) mode. 



Remote Access VisiLogic: Utilities

22 VisiLogic: Utilities

Communication-PC Settings
This enables you to check communication parameters and perform certain 
actions. 

 PC Communication Settings 
 Run, Reset, Initialize 
 Get Com Parameters and PLC status 
 Check Network Status 

 

Direct Connection: PC-Controller 
Connect your PC to any controller using the programming cable supplied with 
the controller kit. 

 

Accessing a Networked Controller 

1. Connect your PC to any controller in the network using the programming 
cable supplied with the controller kit.
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Note ♦ Different PCs can access a network at the same time, using different 
controller units as bridges. However, 2 different PCs cannot 
simultaneously access the same controller unit. 

2. Select a networked controller by opening Communication & OS from the 
Tools menu, and then entering the Unit ID number. 

 

Remote Access via Modem
To access either stand-alone or networked controllers via GSM or landline 
modem: 
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Before integrating modems into your applications, check the topics Modems-
Tips & Cautions, and PLC to Modem Connections and Pin-outs. 

Modems: Setting Up 

PLC-side Modem 
To enable a modem to work with a PLC, it must be properly initialized. 

1. Connect the modem to a PC, using the cable supplied by the modem 
manufacturer.

2. Open Connection>Modem Services, and select the modem type. If 
required, you can edit other parameters: 

 Com Port, baud rate, Time Out, and Time-Out Reply: use the 
drop down boxes 

 PIN code: click to enter the number. 
3. Click the Prepare PLC-side Modem button to open the dialog box shown 

below. 

4. If required, edit initialization commands by clicking in the field and 
entering text. 

5. When all parameters are set, click the Init Modem button; the PC 
establishes communication with the modem and initializes it. 
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PC-side Modem 
1. Connect the modem to a PC, using the cable supplied by the 

modem manufacturer. Check the PLC to Modem Connections and 
Pinouts for more information. 

2. Open Modem Services from the Connection menu. 

3. Select and enter the modem parameters: 

1. At the top of Modem Services, select a tab; the Modem Type 
selection box shows the options. 

2. Select the PC modem type; the initialization strings change 
accordingly. 

3. If required, you can edit other parameters: 

 Initialization commands: click in the field and enter text. 
 Com Port, baud rate, Time Out, and Time-Out Reply: use the 

drop down boxes 
 PIN code: click to enter the number. 

4. When all parameters are set, click the Initialize PC Modem button; 
the PC establishes communication with the modem and initializes it. 
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How to use the PC modem to access a PLC 
1. Prepare and connect the PLC-side modem as described above. 

2. Dial the PLC to establish the communication link: 

c. In Tools>Modem Services, click the button to the right of the Number 
to Dial field to open Favorites and select a number. 

d. Click a line to enter or select a number and description. To access 
outside lines, enter the access number required, a comma, then the 
phone number. 

e. Click Dial. 
 Once Remote Access establishes the communication link, click the OnLine 

icon to enter Test (Debug) mode. 

To break the data link, click Hang-Up. 

 

Wait for Incoming Call 
Click the Wait for Incoming Call button in Modem Services to place the PC 
modem in auto-answer mode. 

Additional options

Sessions 
Sessions enable you to save communication settings, and restore them at any 
time. 

1. Open Remote Access, and select the appropriate communication options 
in Communication - PC settings and Modem Services. 
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2. Select Session from the Tools menu. Enter a name for the Session, and 
then click Save to add it to the Session list. 

 
3. To select a Session, highlight it and click the Activate button. 
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.ura and .urc: HMI cache files (Vision only) 
HMI cache files enable Remote Access to refer to HMI elements stored in the PC, 
instead of taking them from the PLC. 
 

Monochrome Vision 
A cache file enables Remote Operator to load Displays more quickly.  
The HMI cache files are in .ura format.   
(note that V130, which loads displays quickly, does not use .ura files.) 
 

Color Vision 
If a cache file is not used, images will not be displayed and fonts may be 
distorted. 
A cache file includes fonts, and can include images. However, note that if 
the file does not include images, Remote Access will display a red 'X' in 
place of graphics. 
The HMI cache files are in .urc format.  
Such files can be created in Remote Access by selecting the option Create 
Fonts and Images (*.urc) from PLC. 
 

Note ♦ When Remote Access creates a .urc file, the Vision enters 'System 
Mode'; the PLC continues running while displaying a system image. 
The HMI application is not visible. 
In addition, note that an interruption in communications may leave 
the PLC inaccessible. In this case, the PLC may require reset, which 
requires an operator to be physically present near the PLC. 



Remote Access VisiLogic: Utilities

30 VisiLogic: Utilities

Always on Top 
Select this to keep Remote Access displayed on top of all other applications. 

 
Online Mode

Once you have configured Remote Access, enter Online mode by clicking the 

button . 

In this mode, you can: 

 Use your cursor to operate the controller keypad and activate touch-
screen objects (relevant models). 

 Use your PC keyboard to operate the controller keypad (numeric keys, 
function keys <F1> to <F8>). Note that the Vision <ESC> key is <E> on 
the PC keyboard, and that <F9> is reserved for activating Online mode. 

 Enter Information Mode by pressing the <i> key with your cursor. 
 Select a View .  

Note ♦ The Zoom option on the View menu can be activated only if you 
select Hide Keys. Zoom cannot be used with M90/91 or V280 controllers. 

 

PC Com Parameters (non-modem) 
Display the current communication settings by selecting Communication - PC 
Settings from the Options menu. 



VisiLogic: Utilities Remote Access

VisiLogic: Utilities 31

Select 
Connection 
type 

Use the drop-down arrow to select serial or Ethernet. 

PC Com 
Parameters 

Port, Retries and Time-Out are the communication settings between Remote 
Access and the controller. Note that if you are working with a network, the 
TimeOut should be greater than 1 second. 

Communicate 
with OPLC 

Use these options to communicate with networked controllers.  
Direct Connection: select this to communicate with any controller that is 
connected to your PC via the download cable, including a network bridge. 
Within Network:select this to communicate with a controller that is 
integrated into a network, then select the controller's ID number 

OPLC 
Information 

Click Get OPLC Information to display information about the controller 
you have selected in Communicate with OPLC. 
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Run, Reset, Initialize 
 

Note ♦ When you click a 
button, your PC will access the 
controller selected in PC 
Communication Settings.

Set RTC These are the values of your PC's clock. Click Set RTC to import these 
values into the RTC of the controller. 

Get Vision 
RTC Current 
Values 

Click to view the current PLC settings 
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Run Click to run the current program in the PLC. 

Stop Click to stop the current PLC program. 

Reset Click to reset the PLC, and reinstall any values preset in the program, such as 
Timers. 

Reset & 
Initialize 

Click to reset, reinstall any preset values, and initialize all memory operands 

Get Com Parameters and PLC status 
 

Select Get to view 
communication parameters and 
PLC status in the controller you 
are currently communicating 
with. 
This is the controller selected in  
PC Communication Settings.

Check Network Status 
The network status is checked via the bridge. 
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Operand Access 
Operand Access is located on the Tools menu. This utility enables you to 
access operands in a local or remote controller and perform the operations 
listed below. 

 

• View remote operands in the Operand Access table, then define and name 
regions.

To define regions: 

1. Click and drag the cursor over regions to select them. 

2. Click the Add New Region button. 



VisiLogic: Utilities Remote Access

VisiLogic: Utilities 35

Save region definitions in .vxt files. 

In order to open a .vxt file, you must select the controller series 
(Configure>OPLC model, either Vision or M90/91) which was selected 
when the .vxt file was saved. 

• View real-time operand values in Online mode. 

1. Click the Online icon; real-time values appear in blue. 
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• Read operand values from the controller. 

1. Click the Read icon; all values are read in all of the defined regions. 

 

• Write MB, MI, ML and DW values to the controller. 

Note ♦ You can also write values to the M90 Database integers. 

1. Enter values, then click write; all of the values in all of the defined 
regions are written to the controller. 



VisiLogic: Utilities Remote Access

VisiLogic: Utilities 37

Use the Windows Clipboard to Cut/Copy/Paste values to/from the 
Operand Access table and third-party editors such as Excel. 

Note ♦ The Paste destination within Operand Access must be large 
enough to hold the Clipboard contents. Clipboard contents are pasted 
to the right and down. 

 
• Export/Import Operand values to/from an Excel spreadsheet customized 

to Unitronics' PLC Data Types. 

Within Excel, values can be edited, imported to Operand Access, then 
written to the controller 

 
To export real-time values from the PLC to Excel: 
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1. Create a region containing the operand values you wish to export. 

2. Select Read Regions in order to update those values,. 

3. Select Export to Excel. 

Note ♦ Not all operand values are updated with real-time values when 
you run On Line mode. When you run On Line mode, only the values that 
are displayed within the Operand Access window are updated. Operands 
that are not displayed in the Operand Access window during On Line are 
not updated. 

Therefore, running On Line mode immediately before Export to Excel does 
not guarantee the export of all updated operand values.   

 
Backup PLC RAM 

You can read all PLC RAM values into an Excel file, and to write these 
Excel values into the PLC's RAM. 

 

Data Tables 
Vision controllers contain Data Tables that can be used to store data, such as 
parameters for recipe files or data logs. 

Data within the tables can be copied and pasted to and from third-party tools 
such as Excel. 

Note ♦ Data Tables are based on bytes, not on registers.
♦ Data Table sections that are marked Part of Project: the data are 

downloaded with the project, and burned into the Flash memory. 
These values can not be edited in Remote Access. 

Data tables consist of columns and rows. 
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Data Table Options

Menu 
Name 

Option 

File Import/Export
Data tables can be imported and exported from Excel. 
Data Tables can also be exported from an application as . upd files, then 
imported. 
When you import the file, you can select to: 

• Add individual tables to the structure. If tables of the same name already 
exist, the tables are automatically renamed. 

• Delete existing tables and import the new structure. 
Memory Requirements 
Displays pie charts that show the amount of memory occupied by the data tables. 

Edit Copy/Paste enable you to copy values and paste them into another location. 

Connection All of the Connection commands require that the PLC be connected to the PC. 
Read Structure from PLC 
Imports the structure of the data tables within the PLC into the project. 
Read Structure and Values from PLC 
Select this to import the values in the data tables together with the table 
structure. 
Verify: Tables Structure 
Compares the table structure in the project to the structure of tables within the 
PLC. 
The commands below also require that the table structure in the PLC be identical 
with the table structure in Remote Access. 
Read Range 
Reads the values of the selected cells from within the PLC data table into the 
project. 
Write Range 
Writes the values of the selected cells from the project data table into the PLC. 
Verify Cell Value: by Range 
Compares the values of the cells in the project to the values within the PLC. 

Column Set Cell Value
Enables you to enter values for a cell or range of cells within a column. 
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Data Tables, Excel, and .csv
Data can be imported to and exported from Excel and .csv files. 

Export 

Note that you can include the current values by establishing a communication 
connection with the PLC and reading or writing values from specific cells, or 
from an entire Data Table within the PLC into the Data Table.

To export data 

1. Highlight the cells containing the desired data. 
Click the Export to Excel or Export to .csv button. 

2. Follow the on-screen instructions; data is exported into the desired file 
type. 

 

Import 

To import data 

1. Click the Import to Excel or Import to .csv button. 

2. Follow the on-screen instructions; data is exported into the desired file 
type. 

The data is copied as shown below. 

 
Copy & paste data 

To copy/paste data to and from Data Tables and Excel. 

1. Select data. You can select individual cells, rows, columns, or contiguous 
groups of cells. 

2. Copy the values to the Clipboard either by pressing <Ctrl>+ <C> or by 
clicking the Copy button. 

3. Click the cursor in the Paste location, then paste the either press <Ctrl> 
+ <V> or click the Paste button. 

Note ♦ The selection is pasted towards the right and down. When you paste 
from Excel to Data Tables, the Data Table must have enough rows and 
columns to contain the Paste selection. 
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UniVision Licensing  
You can create a PLC license number and burn it into a secured, hidden sector 
in the PLC. 

You can then use this license in your Ladder to control how your program 
functions. 

To license the PLC, use the UniVision Licensing function on the Utils menu may 
be used in conjunction with the UniVision Licensing stand-alone utility, which 
may be freely downloaded from 
http://unitronics.com/Content.aspx?page=Downloads 

 

The result of the License operation can then be used to activate or deactivate 
different sections of your application. 

The UniVision Licensing utility enables you to create two kinds of licenses: 

• One that licenses the program, but that is not bound to a particular PLC 

• One that licenses the program, and incorporates a specific PLC ID 
number. This type will only license the specific PLC it is generated for. 
Note that you can use this type to license a remote end user's PLC. 

 

Generate and burn a license, without PLC ID number

1. In the UniVision Licensing utility, click on the first tab, Programmer: 
Create & Burn License. 

2. Enter the key number. 
This is the first part of the license (input A). 

3. Enter the values for Data1, Data2, and Data3. 
This is the second part of the license (input B). 

4. You can use the Generate buttons to create these values. 
The fact that there are 3 values enables you to create levels of access. 

5. Establish a communication connection to the PLC, and press Burn License 
to PLC. 

http://unitronics.com./Content.aspx?page=Downloads
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Generate and burn a license comprising a PLC Unique ID number

In this case, you must establish a communication link with the specific PLC 
which is to be licensed, and generate a KeyGen number. The KeyGen number 
encrypts the PLC's Unique ID Number. You use this number to generate the 
license, which is specific to that PLC. This license number will not work in 
any other PLC. 

 

Providing a license to a remote customer
Note that you can send the UniVision Licensing utility to a customer. 
The customer can email you the KeyGen number; you use this to 
generate the license number and send it back to the customer, 
who can then license the PLC. 

First, get the KeyGen number: 

1. In the UniVision Licensing utility, click the Customer:Get License tab. 

2. Establish a communication connection to the PLC. 

3. Click Generate, and then the Copy button. 
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Next, generate the license: 

4. Paste the value into the KeyGen field, and fill in the Key and Data values 

5. Click Generate License, and then the Copy button.. 
 

Now, license the PLC: 
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6. Paste the number into the Customer License field, and press Send License 
to PLC to burn it to the PLC. 
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VisiLogic Version Swapper     
You can roll back and forth between VisiLogic versions by using the VisiLogic 
Version Swapper utility. Swapper is part of the VisiLogic installation version 
4.70 and later. 

To use Swapper: 

1. Create folders containing different VisiLogic Versions. 
 

2. To obtain VisiLogic versions either: 
 
- Use the Unitronics Setup CD. The CD contains a folder 
VisiLogic\Current\Installs\VisiLogic Old versions. 
 Copy these folders to the Unitronics directory, which is typically located in 
C:\Program Files\Unitronics. 
 
-or- 
 
- From within the Swapper, click on the link Click here to open the 
VisiLogic Download site. If you are connected to the Internet, this will 
open a page in the Unitronics' website that contains different VisiLogic 
versions. Click on the desired version to download it as a .zip file, and 
then extract them to the Unitronics directory.  

2. If VisiLogic is open, close it. 
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3. Open Swapper from Programs>Unitronics>VisiLogic> VisiLogic Version 
Swapper. 

4. Navigate to the Unitronics folder containing the desired version. 

5. In the Vision Installation Directories window ,select a version folder.

6. Click the Register button ;Windows will register the .dlls of the selected VisiLogic version .
When registration is complete ,Swapper asks if you want a shortcut placed on your desktop .

Select Yes ;Swapper closes automatically .You can now start the registered version.

When you install a newly-released VisiLogic version, you may want to 
keep the former version to use with the Swapper. 

When VisiLogic installs into a PC with an existing VisiLogic installation, it 
overwrites the Unitronics VisiLogic folder. This is one way to save the existing 
installation: 

1. In Windows Explorer, right-click the folder Unitronics VisiLogic. 

2. Select Copy from the right-click menu. 
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3. Select Paste from the right-click menu. When you paste the folder into the 
same directory, most versions of Windows will create a new 'Copy of' 
folder. 
When Windows finishes creating Copy of Unitronics VisiLogic, install your 
new VisiLogic version. 

4. After you complete the installation, rename the Copy of Unitronics 
VisiLogic folder with the true version name, for example Unitronics 
VisiLogic 4.70. 
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DataXport 
DataXport creates logs of run-time or stored data from Data Tables and 
operand regions within Unitronics PLCs.  DataXport saves the data logs in .ulp 
format. You can open these data logs using DataXport's companion application, 
DataXls, and then export the data to Excel files. 

Via DataXport, you can: 

 Log data according to a date/time-based schedule. 
 Simultaneously log data from one or more Unitronics PLCs. 
 Access PLCs and log data via a direct, network, Ethernet, or modem 

connection. 
 Save the data that is logged during each session to an Excel file, 

and automatically email it at the end of a session. 

 

Building a DataXport Project 
Start DataXport:   

1. Go to Start > Programs > Unitronics> DataXport.  
-or- 
Open the Unitronics folder located on the Desktop, then double-click on the 
DataXport icon.  Note that DataXport is installed in the Unitronics program 
group by default. It is stored elsewhere only if you specified another program 
group during installation. 

2. The DataXport design window opens. 

The DataXport Design window displays the list of Site you include in the 
project, together with the parameters of how the PLC within the Site is 
accessed. 
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To build a 
DataXport 
project, you first 
define the 
project's modules 
listed on the 
right. These 
modules 
determine when 
the data is 
logged, which 
data is logged, 
and how the PLC 
can be accessed. 
 
Once their 
parameters are 
defined, all of 
these modules 
are global to the 
entire DataXport 
project and may 
be linked to any 
PLC in the Site 
List. 
The Site List 
comprises all of 
the PLCs in the 
project together 
with all of the 
linked 
parameters. 
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Module 1: Schedules - When to Log 
The Schedule determines the time intervals data between data log actions. 

1. Select Schedules from the Design menu. 

2. Click Add to create a new schedule, click Edit or double-click a line to 
redefine an existing schedule; the Schedule opens. 

3. Make the appropriate entries, then click OK to add the Schedule to the 
list. 

 

Module 2:Tables & Regions - What to Log 
DataXport can log data either from Data Tables, an M90/91 PLC's Database, or 
from Regions of operands. 

Vision Data Tables
To log data from PLC Data Tables within Vision PLCs, DataXport must first 
import Data Table structures from the PLC.  To do this, DataXport can access 
the PLC via direct connection, modem,  Ethernet, or CANbus/ RS485. 

Check the related topic, Linking to a PLC to Import Data Tables. 

Table assigns a working name to the data that is harvested from a PLC Data 
Table. 

1. Select Tables from the Design menu. 

2. Click on the Import Data Table Structure button, then click Add to append 
it to the list. 

3. Name the Data Table Structure, then either: 

 Read the structure from the PLC 
-or- 
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Import a .upd file. 

 
Notes ♦ If the PC does not have a working communications link to the PLC as 

described in the topic Linking to a PLC to Import Data Tables, you will 
not be able to import Table structures.. 

♦ If your project includes more than one PLC, and the Data Tables in 
these PLCs are identical, you do not have to import them from each 
PLC. Importing un-needed Data Tables will make the project very 
'heavy'. 

Once the Data Tables have been imported from the PLC, they are listed in the 
Data Table Structure left-hand pane as shown below. Highlighting one displays 
the Table names in the right hand pane. 

4. Click a Structure, select a Table within the structure, and then enter Rows 
to Read for that specific table. The Read From and Read To pointers are 
linked to DWs in the PLC. The DW values determine the length of the 
block of data that is collected from the PLC Data Table each time the site 
is scanned. 
You can also select the Read Entire The PLC can now read an entire table 
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during a session, without using FIFO pointers. 

 

M90 Database
The M90 OPLC has a special memory area containing integers that are function 
as a database. These integers are not related in any way to system or memory 
integers.  Within the database, you can access and use integers 0 through 
1023 via SI 40 and SI 41. 

Since, unlike Vision PLCs, the M90 database is not structured, there is no 
structure to import.   

Table assigns a working name to the data that is harvested from a PLC Data 
Table. 

1. Select Tables from the Design menu. 

2. Click on the M90 tab. 

3. Name the Data Table Structure, enter the Start Address and other 
parameters; and then click OK; the Table is added to the list. 
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Notes 
♦

An Invalid FIFO pointers error results if a FIFO pointer is out of the 
range of MI addresses used for the M90 Database. 

Data Regions
Defining regions enables you to harvest data from the operands within a PLC. 

1. Select Regions from the Design menu; the Regions window opens. 

2. Enter parameters as shown below. 

 

Reading values: FIFO Pointers
The FIFO pointers determine the size of the block of data read during a 
DataXport call. 
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Pointer: Read from / FIFO out (MI), incremented by DataXport. 
This MI is incremented by DataXport after each reading. It should not 
be used for any other purpose in your Ladder application. 

 Pointer: Read to / FIFO In (MI), incremented by PLC. 
This is the MI you use in your Ladder application to indicate which data 
is to be logged. It is generally the MI you use to fill the Data Table. 

 MB to set (optional): this MB is turned ON by DataXport after each 
reading. You must reset this bit in your application after each reading. 

 

Example 

An application stores a temperature value into a PLC Data Table every minute. 
Each time the temperature is stored into a Data Table register, MI 150 is 
incremented by one. The incrementing value enables the temperature to be 
stored into consecutive Data Table registers. Within the DataXport project, MI 
150 is the Pointer: Read to / FIFO In, and MI 100 is the Pointer: Read from / 
FIFO Out. 

The DataXport application is set to call the PLC and log data every 20 minutes. 

When the application starts running, both MI150 (PLC pointer) and MI100 (PC 
pointer) hold 0. MI 150 is incremented by 1 every minute, when the 
temperature is stored into the PLC.  After 20 minutes, the value of MI 150 will 
be 19. 

DataXport then calls the PLC. During the call, DataXport logs Data Table values 
from register 0 to 19, and then writes '19' into MI100.  The PLC application 
continues running; each minute the temperature is stored and MI 150 is 
incremented by 1. 

At the beginning of the next DataXport call, 20 minutes later, the value of MI 
150 will be 39, while the value of MI100 will still be 19. During the call, 
DataXport will log the new values--from 20 to 39--and will write '39' into MI 
100. 

Notes ♦ An Invalid FIFO pointers error results if a FIFO pointer is:
Less than 0. 

 Greater than or equal to the number of rows in the Data 
Table. 
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Module 3: Ports - How to Access the PLC 
Ports determine the parameters of the communication link that is used by the 
PC running DataXport in order to access a PLC and log data. 

Note ♦ The Connection menu options are not related to the way the PC 
(DataXport) will access a PLC in order to log data. Connection menu 
options are only used to access a PLC in order to import Data Table 
structures from Vision PLCs. 

♦ The PLC name must be identical to the name assigned in the 
controller's Ladder application via Set PLC Name. 

1. Select Ports from the Design menu; the PC Ports window opens. 

2. Double-click a line to open PC Port Settings, then make the desired 
selections.. 

Note that the lower lines in the PC Ports windows can be configured for TAPI, 
and the last 2 lines for Ethernet. 

 

Ethernet Listen sets a particular PC port, via which PLCs can 'call' and connect 
to the PC. Once the connection is established, the PC will export whatever data 
is set for that PLC. 
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Linking PLCs to Modules: the Site List 
Once all of the modules have been defined, you can create the Site List. 

1. Select Add Site from the Design menu; the PLC window opens. 

2. In the left-hand pane, enter the PLC name, then select the module 
parameters displayed on the right-hand side of the PLC window as shown 
below. 

The PLC name must be identical to the name assigned in the 
controller's Ladder application via Set PLC Name. 

3. Make the appropriate selections regarding PLC type. 

4. Select a PC port, the COM ports that are offered are the ones defined in 
the Ports Module. The required parameters in this section change 
according to the port you select. For example, if you select a port 
connected to a modem, you fill in a phone number; if you select an 
Ethernet port, relevant parameters such as IP address are required. 

5. Select MB to set if you want a specific MB to turn ON when this PLC is 
accessed. 

6. Select Enabled if the PC is to include this specific PLC site when the 
DataXport project is run.  If Enabled is not selected, data will not be 
logged from this PLC even though it appears in the project. 

7. If the PLC is in a network, select that option and the correct Network ID. 

8. Select Excel files to cause DataXport to create an Excel file whenever a 
data log is created. Note that DataXport creates a separate Excel file for 
each data log. 
 

Note ♦ If you do not select the Use Excel Template option, DataXport will use a 
default Excel template. To cause DataXport to use a customised Excel 
template: 
a. Select Use Excel Template. 
b. Store the template in the folder :::\\DataXport\Excel Templates. 
 
The name of the Excel template must be identical to the PLC Name 
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given in the Site.
9. In the right-hand pane, select the desired 

 Schedules, 
 Tables and/or Regions, 
 Emails 

These are all of the parameters that have already been defined in the project. 

Note ♦ All modules; Schedules, Ports, Tables and/or Regions; are global to the 
entire DataXport project. You can link any module to any number of 
Sites. 

10.When the PLC has been defined, click OK, the PLC is added to the list and 
will be displayed in the DataXport Design window. When the list is 
complete, save and name the project. 
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To edit the parameters of a PLC that is already in the list, double-click the line 
to open it. 

 

Checking the Project 
When the project is complete, Select Check from the Actions menu to find any 
errors. 

After correcting any errors, you can run the project 
 

Running the DataXport Project 
Run, located on the Actions menu, activates the DataXport project. 

1. Select Run from the Actions menu, DataXport begins exporting the 
requested data from Data Tables and operands within the target PLCS, via 
the defined ports and according to the defined schedules. 

Note that you can also force a call. 

 

You can also cause a DataXport project to enter Run Mode whenever the project 
is opened by selecting that option from the Actions menu. 
 

Force Call 
You can force the PC to call a PLC and export the data tables/regions defined 
for that PLC in one of two ways: 

 By sending an SMS message to the PC's GSM modem. Assuming 
that the name of the site is Production 1, the SMS must read 
DATAXPORT CALL TO: Production 1 
Note the capital letters and semicolon. 

 By selecting Run Project, and then clicking the Force Call button 
shown below. 
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Viewing Logs 
View, located on the Project menu, shows the DataXport log calls. To view the 
logged data, use DataXls. 

1. Select View from the Project menu, Site status is displayed. 

 

DataXls: Accessing Data Logs 
DataXls enables you to open the logs in Excel format. You can then manipulate 
the data in Excel. 

Start DataXls:   

1. Go to Start > Programs > Unitronics> DataXls.  
-or- 
Open the Unitronics folder located on the Desktop, then double-click on the 
DataXls icon.   
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2. Click the Open icon, then navigate to the desired .ulp project and click Open. 

 

DataXls opens the project as shown below. 

3. To view files in Excel, drag the mouse over a log to highlight it, then either: 
- Select the Excel icon from the toolbar,or, 
-Right-click the highlighted area and select Send Selected to Excel. 
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UniOPC Server    
UniOPC Server (Unitronics OPC Server) enables you to read and write data 
between Unitronics PLCs and applications that support OPC, such as SCADA 
programs. UniOPC Server is compliant with the OPC Foundation's Data Access 
Custom Interface Standards through to Version 3.00. 

UniOPC Server runs independently of other Unitronics software. 

Registering UniOPC Server 
In order for UniOPC Server to be registered in your PC's list of OPC servers, 
you must register UniOPC Server the first time you run the program, either by 
clicking the Register button or selecting Register from the Registration menu. 
Once it is registered, UniOPC will appear in your OPC client software's server 
list. To remove UniOPC Server from the client's list, select UnRegister from the 
Registration menu. 
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UniOPC Server - DCOM 

Installation Prerequisites

Operating System

Although it is possible to run OPC using Windows 95, Windows 98, Windows 
NT, Windows 2000, this requires specific dlls. Therefore, we strongly 
recommend using Windows XP. 

Privileges

In order to be able to set all the required DCOM properties, the user must log 
on with administrator privileges. 

UniOPCServer installation

Although OPC servers can be installed by any user having administrator 
privileges, we recommend that installation be done under local administrator 
log-on. In compliance with the OPC DA v2.x specifications, it is recommended to use the OPCEnum 
application, which enables OPC clients to browse the available OPC servers. 
This application is installed together with UniOPC Server. 

User groups

If several users have access rights to a given OPC server, we recommend you 
create a user group. This group should be duplicated on all the PCs where the 
OPC Server will be installed. 

PC Server Settings

Since OPC security is based on DCOM security, default security settings 
selected for the OPC server and OPC client machines will affect all executables 
irrespective of their link to OPC. 

The settings recommended in this document allow broad access to the 
executables installed on the PC, while restricting access to the critical OPC 
servers, meaning those that allow access to actual devices. 

Setting Default Permission
1. Open Start>Settings>Control Panel> Administrative Tools> Component 

Services. 
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2. Click on Component Services, and then right-click My Computer. 
 

3. Click on Properties, and then select the Default properties Tab. 

4. Select the settings shown below, and then click Apply. 
 

5. Select the COM Security tab. 
 



VisiLogic: Utilities UniOPC Server

VisiLogic: Utilities 17

6. In order to add users, open the Default Access Permission window by 
clicking on the corresponding Edit Default button. 

7. Set the appropriate user access rights, and then click OK. 
 

8. Set Default Launch Permissions by clicking on the corresponding Edit 
Default button and adding users. 
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9. Set the appropriate user access rights, and then click OK. 
 

10.Click on Apply in the COM Security window. 
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11.Click the Default Protocols tab. The default protocols should appear as 
shown in the figure below; if they do not, update them. 
 

12.Click OK. 

OPCEnum Settings

Once the settings have been applied, configure the settings of the OPCEnum 
application. OPCEnum is the application used by any OPC DA2.0 client to 
browse the available OPC servers on the local machine. The required settings 
are the default ones. They are accessible from the Component Services 
window: 

1. Select Component Services>My Computer>DCOM Config. 
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2. Click on OpcEnum. 
 

3. Right-Click on OPCEnum and select Properties. 

4. The default settings in the General tab are displayed in the next figure. 
 

5. In the Location tab, enter the choices displayed in the next figure. 
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6. Click on the Security tab, and then enter the choices displayed in the next 
figure. 

7. In the Configuration Permission window, reduce the privileges of the 
Power Users as shown in the next figure. 
 

8. In the Identity tab window, enter the choices shown in the next figure 
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9. In the “Endpoints” window, keep the default settings. 

UniOPC Server Settings

Next, you need to configure UniOPC Server’s settings 

1. Right-click on UniOPC Server in the main dcomcnfg window, and then click 
on Properties. A tabbed window opens, enabling you to edit UniOPC 
Server settings. 
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2. Under General, Authentication Level should be set to Default. 
 

3. Under Location, select Run application on the computer. This is because 
the program is installed on the local machine. 
 

4. Under Security, change the default settings as shown below.  These 
settings restrict remote access to the defined users group. 

5. Under Access Permissions, press Edit. 
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6. Set the same access rights for all groups as shown below. 
 

7. Under Launch Permissions, press Edit. Set the same access rights for all 
groups as shown below. 
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8. Under Configuration Permissions, press Edit. Set the same access rights 
for all groups as shown below. Set special privileges to Power Users if 
different than default. 
 

9. For the Identity property, you must select a given user. If Launching is 
selected, several OPC server instances may be created when different 
users will try to connect. This is usually not possible if the OPC server 
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instances require access to a given resource (e.g. PC Card). If 
“interactive” is selected, the OPC server will not be able to start without 
any active user session. The selected user must be member of the locally 
created group. 
 

10.To include this account in the local administrator group, right-click 
Administrators, and then select Properties. 
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11.The Endpoint property must be set to default. 

Configuring the Windows Firewall

The Windows Firewall allows traffic across the network interface when initiated 
locally, but by default stops any incoming “unsolicited” traffic.  However, this 
firewall is “exception” based, meaning that the administrator can specify 
applications and ports that are exceptions to the rule and can respond to 
unsolicited requests. 

The firewall exceptions can be specified at two main levels, the application 
level and the port and protocol level. The application level is where you specify 
which applications are able to respond to unsolicited requests and the port and 
protocol level is where you can specify the firewall to allow or disallow traffic 
on a specific port for either TCP or UDP traffic. 

By default, Windows Firewall is set to “On”. This setting is recommended by 
Microsoft and by OPC. However, you may need to temporarily turn off the 
firewall in order to check if the firewall configuration is causing communication 
failures. 

1. Open Windows Firewall by clicking on the Firewall icon in the Windows 
Control Panel.  

2. Click on the Exceptions tab, and then add all OPC Clients and Servers to 
the exception list. In addition, add the Microsoft Management Console 
(mmc.exe found in the Windows\System32 directory) and the OPC utility 
OPCEnum (opcenum.exe found in the Windows\System32 
directory).  Note that these two files may not appear in the Add a Program 
list and will have to be found by using the Browse button.  Lastly, you 
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need to ensure that File and Printer Sharing is checked.  This is not 
typically enabled on new installations of the Operating System. 
 

3. Add TCP port 135. This port is needed to initiate DCOM communications, 
and allow for incoming echo requests. In the Exceptions tab of the 
Windows Firewall, click on Add Port. 
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4. In the Add a Port dialog, fill out the fields as shown below: 
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Using UniOPC Server 
To use UniOPC Server, you first define a communication channel list. Next, you 
define the PLCs you want to access with UniOPC Server, and then click Run to 
enable UniOPC Server. 

Note that the data is gathered by a client application, such as a SCADA 
program, according to client requests, without regard to how often UniOPC 
Server harvests data from the PLCs. UniOPC does not initiate data calls to the 
client. 

Creating a Channel list

A Channel includes the port and other PC communication parameters. The PC 
uses the channel to access a PLC and gather data. 

1. Click the Channel icon, Channels Collection opens. 
 

2. Click Add; Channel opens.   

3. Under Connection type, click the drop-down arrow to select Serial or 
TCP/IP. The options change according to your selection, enabling you to 
fill in the PC Communication Parameters. 
The Update Rate is the frequency at which UniOPC Servers harvest data 
from the PLCs linked to the channel. Note, however, that the rate at which 
the client takes data from UniOPC Server is set within the client 
application. 
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4. Click OK to add the Channel to the Channel Collection 
 

Creating a PLC list
1. Click Add PLC. 

2. Enter a unique PLC name, then select the PLC type and Unit ID. 
Note that the Enable option is selected by default; this enables a client 
application to access the PLC. 

3. Select a Channel; and then click OK. 
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Parameters   

PLC • Name: Enter a unique PLC description. 
• Type: Select Vision, M90/91 Stand-alone, or M90/91 via Vision. 
• Unit ID: Select either Direct, or the PLC's CANbus/RS485 Unit ID number. 
• Channel: Select this from the Channel list. 
• Enabled: This option must be checked in order for the OPC client application to access the PLC. 

Note ♦ A single channel can be linked to up to a number of PLCs.
♦ The PLC list relates to the PLC name. This means that UNIOPC will 

communicate with the correct PLC, without regard to Unit ID. 
 
Note that, in Vision, the PLC name in the channel list must match the 
one given in the Ladder program by the PLC Name function. 
 

4. Click Run; a client application can now exchange data with all enabled 
PLCs in the list. 
Note that if UniOPC has not been registered, the Run button is disabled. 

Multi-channel applications

Note that if you have a large project, containing a number of PLCs linked to 
the same channel defined as TCP/IP listen, and the OPC client sends data to a 
PLC that is off-line, UniOPC stores the data. As soon as the PLC comes on-line 
and connects to the channel, UniOPC sends the data. 
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OPC Client: Item Syntax 
To enable the OPC client to access the data types in the PLC, the syntax used 
to define the 'item' must be structured as
<Address> 

Therefore, to access Memory Bit 3 in PLC Conveyor 1, the correct item syntax 
is: 

PLCConveyor1.MB3 

Note that: 

 The name of the PLC is exact, including spaces and capital letters.

The name is followed by a period.

The Item Prefix is entered in capital letters.

To enable the client application to receive a string giving the status of a PLC, 
create an item, 'string' data type, with the following syntax:

PLCConveyor1.STATUS

Item Syntax Table
Data Type Syntax N

Memory Bit MB 

Memory Integer MI •

•

R

Memory Long Integer ML 

Memory Double Word DW 

Input I 

Output O 

System Bit SB 

System Integer SI 

System Long Integer SL 

System Double Word SDW 

Timer Bit TB 

Timer Value, Current TC I

Timer Value, Preset TP 

Timer Value, Current Long TCL I

Timer Value, Preset Long TPL 

Counter Bit CB 

Counter Value, Current CC I

Counter Value, Preset CP 

Memory Float MF 

t to access the data types in the PLC, the syntax used 
t be structured as follows:<PLCName> <ItemPrefix> 

mory Bit 3 in PLC Conveyor 1, the correct item syntax 

LC is exact, including spaces and capital letters.

ed by a period.

entered in capital letters.

lication to receive a string giving the status of a PLC, 
data type, with the following syntax:

S

Notes

• Read MI vector: include length in parentheses. For example,
PLCCONVERYOR1.MI3(5) reads MIs 3,4,5,6 and 7. 
 

• Read String: Include an upper case ‘s’ in square brackets. For example, 
PLCCONVERYOR1.MI3[S] causes UniOPC to scan 32 successive MIs. Scan 
stops when it:  
-reaches the 32nd element 
-encounters a null character 
-encounters a value outside of the range of 1-254 

Requests that exceed legal length will be ignored.

In client application’s item definition, use a string data type

In client application’s item definition, use a numeric or native data type

In client application’s item definition, use a 16-bit integer data type

UniOPC Server
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UniOPC Server Options 
Options are located on the File menu. 

Start Up

Sets the start mode for UniOPC Server. 

 

TimeOut

Use these to determine time-based client-server access parameters. 

 
• Max. Update Rate: determines the maximum time during which the client 

application can access a server data item. The client will attempt to update 
all of its group data items during this time period. If the client is 
unsuccessful, the items that were not updated enter the Requests Queue 
Count shown at the very bottom of the UniOPC Server Window. 

 
If there are requests in the queue, you can adjust the Max. Update Rate. 

• PLCs TimeOut Retry: This is the time during which the client can attempt to 
retry accessing a PLC. 

• Statistics Sample Period: the period of time in which Statistics are collected. 

Log File

Select this to create a detailed log file that may be stored to a disk location as 
a .txt file and limited to a maximum size. This file may be used for debugging 
purposes. 
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Event Log and Statistics 
The Event Log shows events as they occur. The log is limited to 1000 rows. 

 

Statistics show the current UniOPC events during the Statistics Sample Time 
period. The Events are reported in a cyclic fashion; each reading replaces all 
previous Events. You can change the Sample Time period via File>Options. 
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UniDDE    
UniDDE (Unitronics Dynamic Data Exchange) enables you to read and write 
data between Unitronics PLCs and applications that support DDE, such as 
Excel. Although it is installed as part of the VisiLogic Setup, UniDDE runs 
independently of other Unitronics software.  

To exchange data between PC and PLC via DDE: 

1. In UniDDE, define a PLC: name, operands to be accessed, and the 
connection parameters. Enable PLC must be selected.  

2. Copy the resulting Excel Command. 

3. Open Excel, then paste the command into the worksheet. 

4. Run UniDDE; the Excel worksheet will update with current values. 

The figure below shows how to enable UniDDE read a vector of 5 outputs. 
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Defining a PLC 

1. Start UniDDE from Start>Programs>Unitronics>UniDDE.  

2. Click Define PLC; then enter the appropriate parameters. 

 
Parameters

PLC • Name: Enter the PLC description. Once you have entered a PLC Name, you 
can reselect it using the drop-down arrow. The PLC name is saved with the 
project. 

• Type: Select Vision, M90/91 Stand-alone, or M90/91 via Vision. 
• Unit ID: Select either Direct, or a unit in a CANbus or RS485 network. 

Operands • Type: Select any type of operand. 
• Start Address: Enter the first address of the operand vector. 
• Length: Enter the number of operands. 

Enable Select this to allow the PC to access the PLC when the DDE project is run. If 
Enable is not selected, DDE excludes the PLC when the project is run. 

Direction This determines the direction of the data exchange between the PLC and PC. 
Select Read, Write, or Read/Write. Read/Write enables you to read a dynamic 
value to an Excel cell, and use a Write macro to enter a value. 

Connection 
Type 

This determines the connection that the PC uses to access the PLC. Serial 
communications are supported; TCP/IP may be used with compatible controllers. 

Once the PLC has been defined, you can implement Data Exchange. 
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1. In UniDDE, select and right-click the desired operand, then copy the Excel 
'Read' Command from the UniDDE project. 

2. Open Excel, then paste the command into the worksheet. 

When UniDDE; runs the project, the Excel worksheet will update with current 
values. 

 

In order to write to operands via Excel, you can create a macro to read Excel 
cells and write the value to the operands.  

One way to do this is to add a Command button and then paste the UniDDE 
command into the button's VB code. 

1. In Excel, open the Control Toolbox.  (View> Toolbars> Control Toolbox). 
This causes Excel to enter Design mode. 

2. Place a Command button in the Excel worksheet by clicking on the 
Command Button icon on the Control Toolbox as shown below. 

 

2. In UniDDE, select and right-click the desired operand, then copy the Write 
Macro command. 

 



UniDDE VisiLogic: Utilities

40 VisiLogic: Utilities

3. In Excel, double-click the Command button to access the macro code, 
then paste the UniDDE macro code. 

 

3. Edit the Sheet name and cell location according to your requirements.  

 

4. Exit Design Mode by closing the Control Toolbox. 

 

5. According to the code in this example, when UniDDE runs, clicking the 
Command button will write the value in cell A1 to MI 0 in PLC4. 

 

Instead of a command button, you can use a Change Value event. This causes 
the value you type into an Excel cell to be written to the PLC. 

1. Enter Design Mode and open the Visual Basic editor by selecting View 
Code from the Control Toolbox. 
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2. Select Sheet1 and Worksheet as shown in the figure below.  

 

Using Read\Write enables you to simultaneously view a running operand value 
in Excel and update it. 

To Read\Write to a PLC operand, you need to format 2 Excel cells, one to Read 
the value, and another to contain the write value. In order to write to operands 
via Excel, you can add a Command button and paste the UniDDE command 
into the button's VB code. 

1. In UniDDE, select and right-click the desired operand, then copy the Excel 
'Read' Command from the UniDDE project. 

2. Open Excel, then paste the command into the worksheet  

 

In order to write to the operand, you can create a macro as explained in the 
Write section above. 

According to this example, when UniDDE runs, clicking the Command button 
will write the value in cell A1 to T0 in PLC5. 
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Implementing DDE 
Once you have defined the PLC and the operands to be accessed by UniDDE, 
you must create an Excel file to exchange data. 
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Creating the Excel file 
Read 

1. In UniDDE, select and right-click the desired operand, then copy the Excel 
'Read' Command from the UniDDE project. 

2. Open Excel, then paste the command into the worksheet. 

When UniDDE; runs the project, the Excel worksheet will update with current 
values. 

 

Write 
In order to write to operands via Excel, you can create a macro to read Excel 
cells and write the value to the operands.  

One way to do this is to add a Command button and then paste the UniDDE 
command into the button's VB code. 

1. In Excel, open the Control Toolbox.  (View> Toolbars> Control Toolbox). 
This causes Excel to enter Design mode. 

2. Place a Command button in the Excel worksheet by clicking on the 
Command Button icon on the Control Toolbox as shown below. 

 

2. In UniDDE, select and right-click the desired operand, then copy the Write 
Macro command. 
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3. In Excel, double-click the Command button to access the macro code, 
then paste the UniDDE macro code. 

 

3. Edit the Sheet name and cell location according to your requirements.  

 

4. Exit Design Mode by closing the Control Toolbox. 

 

4. According to the code in this example, when UniDDE runs, clicking the 
Command button will write the value in cell A1 to MI 0 in PLC4. 

 

Instead of a command button, you can use a Change Value event. This causes 
the value you type into an Excel cell to be written to the PLC. 
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1. Enter Design Mode and open the Visual Basic editor by selecting View 
Code from the Control Toolbox. 

 

2. Select Sheet1 and Worksheet as shown in the figure below.  

 
Read\Write 

Using Read\Write enables you to simultaneously view a running operand value 
in Excel and update it. 

To Read\Write to a PLC operand, you need to format 2 Excel cells, one to Read 
the value, and another to contain the write value. In order to write to operands 
via Excel, you can add a Command button and paste the UniDDE command 
into the button's VB code. 

1. In UniDDE, select and right-click the desired operand, then copy the Excel 
'Read' Command from the UniDDE project. 

2. Open Excel, then paste the command into the worksheet  

 

In order to write to the operand, you can create a macro as explained in the 
Write section above. 

According to this example, when UniDDE runs, clicking the Command button 
will write the value in cell A1 to T0 in PLC5. 
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You will not be able to use Excel macros if, in Microsoft Excel, your macro 
security is set to High (Tools>Macros>Security). Note that if you upgrade 
Microsoft Office, macro security may be automatically reset to high; in this 
case the following error may be displayed: 

 

To solve this problem, reset Macro security to a lower level. 
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PID Server    
The PID Server PC utility enables you to auto
Vision and M90/91 controller se
VisiLogic/U90 Setup, PID Server runs independently of other Unitronics 
software. 

How Auto-tune works 
The PID Server utility tunes a PID loop by temporarily disabling the PLC's PID 
function, and tuning the loop 

To enable a PID loop to be auto

The controller must be connected to the I/O module whose output feeds 
energy into PID system.
The PC running PID Server must have an established communication link 
to the controller. 

 The PID Server parameters must be linked to the same operands linked to 
the PLC's PID function.

Note ♦ PID Server will only work with Vision 3.73 and U90 3.70 and higher 
projects saved with the most current version of VisiLogic. To update 
older projects, open them with the current VisiLogic version and save 
them. 

Vision Auto-tune 
Before a PID loop can be auto

The OPLC must be connected to the I/O module whose output feeds 
energy into the PID
The OPLC must be installed with a Ladder application that 
function; the function must be activated by an MB that is used
for that purpose.
uses this MB to disable the PLC's PID functio
The PC running PID Server must have an established communication link 
to the controller. 

 The PID Server parameters must be linked to the same operands linked to 
the OPLC's PID function.
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Auto-tuning with PID Server (Vision)

1. Start PID Server from: 
- within VisiLogic via the menu bar, Tools> PID Server, 
or 
- within Windows via Start>Programs>Unitronics> PID Server. 

2. Click on the New File icon to create a new PID loop Auto-tune file. 

3. Locate Loop Properties in the lower right-hand part of the screen. 
Link all of the parameters to the same operands used in the PID function 
within the Ladder application. To link a parameter, click on the Address 
field and select the desired address. 
You can also import operand addresses. 

 
Note that the Enable PID bit must be the same MB used to activate the 

PID function within the Ladder application. 
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In addition, note that PID Server uses the 32-bit Auto-tune Parameter 
vector to store values. Do not allow your application to overwrite the 
vector. 

 
4. From the Connection menu, click OPLC model, and then select your 

controller type.   

5. From the Connection menu, click Communication - PC Settings, and select 
the appropriate settings. 
 

6. Click the Auto-tune icon. The Stages box opens. 

7. Click on the drop-down arrow to select the number of desired Stages, 
which is the number of samples that Autotune will use in order to analyze 
the system. 

 
8. Click OK; the PID Server utility begins to run. 

Note that by checking the Visible option in Loop Properties, you cause PID 
Server to display a color-coded graphical representation of the Auto-tune 
process.   
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Older PID Server Applications
AutoTune Algorithm is a feature added with PID Server V4.00.

Type A 
Previous to V 4.00, PID Server used Type A to tune all PID loops.
Type B (default) 
When this algorithm runs, PID server uses a vector 32 MIs long to store 
Auto-tune Parameters. Do not overwrite this vector in your application.

feature added with PID Server V4.00.

PID Server used Type A to tune all PID loops.

m runs, PID server uses a vector 32 MIs long to store 
ers. Do not overwrite this vector in your application.
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Note ♦ If the system you are tuning has critical limits that are close to the 
setpoint, you may need to avoid drastically overshooting the setpoint 
during autotune. 
To accomplish this in, for example, a heating system, run an initial 
autotune procedure using a setpoint temperature lower than that the 
desired, final temperature.  You can then observe the system 
temperature reaction, and repeat autotune, gradually increasing the 
setpoint temperature until the system reaches the desired temperature. 

Controlling the Physical Output
Before beginning auto-tune, you may want to control and initialize the actual 
physical output that feeds energy into the PID-controlled system. If, for 
example, you are using a V120-12-UN2, you can suspend the action of a high-
speed output by using Ladder Logic to turn off the Output's Run MB, and 
initialize the output by storing 0 into the linked MI in the Ladder program. 
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M90/91 Auto-tune 
Before a PID loop can be auto

The OPLC must be connected to the I/O module whose output feeds 
energy into the PID
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loop is auto-tuned, the PID Server utility uses this MB to disable the PLC's 
PID function. 
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to the controller. 

 The PID Server parameters must be linked to the same operands linked to 
the PLC's PID function.

Auto-tuning with PID Server (M90/91)

1. Start PID Server from:
- within VisiLogic via the menu bar, Tools> PID Server
or 
- within Windows via Start>Programs>Unitronics> PID Server.

2. Click on the New File icon to create a new PID loop Auto

3. Locate Loop Properties in the lower right
Link all of the parameters to the same operands used in 
within the U90Ladder application. To link a parameter, click on the 
Address field and select the desired address.
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The last parameter is the Enable PID bit, which must be the MB used to 
activate the PID function within the U90Ladder application. 

 
4. From the Connection menu, click OPLC model, and then select your 

controller type.   

5. From the Connection menu, click Communication - PC Settings, and select 
the appropriate settings. 
 

6. Click the Auto-tune icon. The PID Server utility begins to run. 
Note that by checking the Visible option in Loop Properties, you cause PID 
Server to display a color-coded graphical representation of the Auto-tune 
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process.   
 

Note ♦ If the system you are tuning has critical limits that are close to the 
setpoint, you may need to avoid drastically overshooting the setpoint 
during autotune. 
To accomplish this in, for example, a heating system, run an initial 
autotune procedure using a setpoint temperature lower than that the 
desired, final temperature.  You can then observe the system 
temperature reaction, and repeat autotune, gradually increasing the 
setpoint temperature until the system reaches the desired temperature. 

Controlling the Physical Output
Before beginning auto-tune, you may want to control and initialize the actual 
physical output that feeds energy into the PID-controlled system. If, for 
example, you are using an M91-12-UN2, you can suspend the action of a high-
speed output by using Ladder Logic to turn off the Output's HSO Enable MB, 
and initialize the output by storing 0 into the linked MI in the Ladder program. 
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PID Server Features 

Import operand addresses
The PID function in VisiLogic enables you to export the PID operand addresses 
in a text file. You can then use the Import operand Address feature to import 
the text file; the PID operand addresses in the text file will be automatically 
addresses entered into PID server. 

 

Saving File Parameters
Whenever you click the Save icon, the file is saved as a .upl file. This file may be 
opened by any PC running PID Server. .upl files include the Loop Properties 
parameter links, comments, and PID auto-tune data up to the time that you click 
Save. If you wish to save only the Loop Properties without the data,  by creating 
them, clicking Save, and storing the file. 
Zoom

Click, then drag the cursor down, then release the mouse button to Zoom in on 
a particular area. 

 

Click and drag the cursor up to reverse the Zoom effect. 
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Increase/Decrease Display View Size

Click the + icon on the toolbar to increase the graph sample size; click the -
icon to decrease it. 
Export
Located on the Loop menu, Export enables you to either export the auto-tune 
data to Excel, or to save a .bmp file of the auto-tune graph. 
Comments
The Comment field is located in the lower left-hand corner of the PID server 
window. Any text you enter here is saved together with the .upl file. 
What's this ?

Our mission is to make automation simple and efficient. Unitronics' R&D has 
developed and field-tested PID Server in order to provide you with fast, easy 
loop tuning. 

To enable us to fine-tune PID Server to suit a broad range of PID applications, 
we would appreciate your using the 'Tell Us' feature. Clicking 'Tell us' will 
create an email with an attached copy of your auto-tune and PID process.   

If possible, before you send the email, please take a moment to put the details 
of your application in the body of the email. 

Note that in Windows XP, Windows will display the following dialog box; simply 
click yes to send the message to Unitronics. 
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